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Exercise 12, based on the following USGS short course.

Modified to be slihttl  siplle,  sse tte latest 201 8 "GeM"" tools  add codtaid po,e exlladatod.
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hede,ated f,op  GI" so  os dod't actsall  deed to do ttat wo,k as la,t of ttis exe,cise.
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Making digital geologic maps with the NCGMP09 
database schema

 allt Hashe,sd  U.". Geolohical "s,ve 

,tashe,sd@sshs.hov

Ma  201 6

Introduction
Tte,e a,e seve,al wa s to sse tte NCGMP09 sctepa wtile c,eatdh a heolohic pal. Eact latt ipllies its 
owd wo,kfow  set of tools  add l,obleps.  ,podh ttese latts a,e:  

1 . Heads-sl dihitiidh ad existdh adaloh pal (pal ipahe) idto tte NCGMP09 sctepa

2. C,eatdh a dew pal b  teads-sl idte,l,etatod add dihitiatod of sos,ce data (field pals  ae,ial 
ltotoh,alts  toloh,altic ipahes  otte, ,epote sedsidh ipahes) wittid  os, GI" ssidh tte 
NCGMP09 sctepa

3. T,adslatdh ad existdh GI" database idto tte NCGMP09 sctepa

Ttese exe,cises depodst,ate tte fi,st two latts.

Prerequisites
Ttis cos,se assspes  os tave tte sse of ,,cGI" (ve,siod 1 0.1  o, tihte,) add a ,easodable fapilia,it  witt 
bott ,,cGI" add heolohic pallidh. 

Typography
Coplste, file add folde, (di,ecto, ) dapes a,e stowd id bold l,olo,todal se,if fodt: C:\ArcGIS. Objects 
(feats,e datasets  feats,e classes  ,aste,s) wittid a heodatabase a,e stowd id tte sape fodt. 
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Widdow  peds  ssb-peds  add textbox dapes a,e id bold sad-se,if fodt; ad ideqsalit  sihd (>) is ssed to 
sela,ate peds > ssbpeds  e.h.  File > Save  o, <,ihtt-click> > Copy. 

Text  os t le  eitte, id a textbox o, at tte coppadd l,oplt  is dedoted b  bold podo-slaced se,if fodt  
e.h.  to save a file sdde, a dew dape id M"Wo,d  click File > Save As add id tte File Name: textbox 
edte, MyNewFilename.doc

ESB1006 Setup
We will need to install a couple ArcGIS "Style" files plus the new 2018 GeMS Toolbox (in place of the 
older NCGMP09v1.1 version listed below).  If it were possible we should also install a couple special 
fonts which contain geological symbols, for example for Triassic or Cambrian.  However permissions 
on the ESB1006 computers are set so that we don't have permission to do that.  We'll just tolerate a 
few symbols being rendered incorrectly.  

In place of the following Setup instructions, for the ESB1006 computers do the following:

Download and unzip the exercise_12 data file.  Within it you will find a Resources directory 
containing various files listed below.  You will also find inside the unzipped directory another zip file, 
GeMS_Tools-02Apr2018, which I just downloaded from the USGS GeMS site.  Unzip that file as 
well which will create a GeMS_Tools-02Apr2018 directory.  We will only use some of the files 
contained within it.  There is also an rrh_resources directory containing contact information files 
I generated (using QGIS) which we will import instead of digitizing everything from scratch.

Before starting ArcMap we also need to edit one of the scripts included in the above USGS toolset to 
fix a bug I've discovered.  Because in the future you may sometime have to make other fixes like this, 
I'm describing how to make the fix rather than simply providing my personal updated version of the 
USGS toolbox.

Use Windows (File) Explorer which you can open with the Windows Key + E or by clicking on 
This PC to open the above GeMS... directory you just extracted.  Inside it (or sometimes inside 
another subdirectory of the same GeMS... name) you should find a Scripts directory containing 
the actual Python code.  Right click on GeMS_MakePoly3_Arc10.py and choose Edit with IDLE.  
(The normal notepad and wordpad editors unfortunately are having problems with the format of 
the latest USGS scripts even though they worked with the older USGS scripts.)  

Search for a line containing the text "Deleting centerPoints2 MapUnit" (without the quotes).  
The next line, which should be Line #178, is what we need to change.  That line creates an sql query 
but there is a mistake.  It reads
sqlQuery = arcpy.AddFieldDelimiters(fds,'MapUnit') + "= '' "       .

To fix this add a space then a \ (backslash) after the final double quote, to continue the statement on 
the next line, then insert a new line under it so the two lines now read as shown below.  You may 
want to use copy and past to duplicate the original line, then modify it.   Be careful to add spaces as 
indicated, especially around the OR and before the IS NULL    .

sqlQuery = arcpy.AddFieldDelimiters(fds,'MapUnit') + "= '' " \

+ " OR " + arcpy.AddFieldDelimiters(fds,'MapUnit') + " IS NULL"

Note that in the above the " is a single character double quotation mark used to indicate the 
beginning and end of the Python text strings.  However the two symbols '' slightly after the equal 
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sign are two back-to-back single quotes, in effect defining a zero length string.  Once you have made 
the change, save the file and exit the IDLE editor.

While you don't really need to know what the above bug fix does to use it, in case you are interested, 
the intention of the original USGS code was to select those polygons for which no MapUnit label had 
yet been assigned.  It tried to do that by checking for an empty string in the MapUnit column of the 
attribute table.  However the sql query is failing (at least some of the time) and the fix is to not only 
check for an empty string, but also to see if MapUnit is equal to the NULL value, which ArcPy is 
somehow treating as different than an empty string.  In a simpler world the new SQL query would 
read
MapUnit = '' OR MapUnit IS NULL

and we could create that with a Python statement reading
sqlQuery = "MapUnit = '' OR MapUnit IS NULL"

but the ArcPy functions are needed to sometimes add [] or double quote marks around MapUnit, 
because in ArcPy the exact syntax depends upon what type of database is storing the layer.

_____________________________________________

With the above editing finally done, start ArcMap and when it offers to create a Blank Map, click 
Cancel.

Open the Style Manager, from the main Customize menu.  Click the Styles button and in the 
Style References window which appears click Add Style to List ...  and navigate the 
resources directory then add the USGS Symbols.style  .   You should now see this style in the 
Style References list, with a checkmark in front of it.  You can enable or disable individual 
styles by setting or clearing the checkmarks.  Repeat the above steps to install the 
FGDC_GSC_20100414.style .  Back in the Style References window, click OK to close the 
window.  You should now be back in the Style Manager Window.  Click the + sign before the FGDC 
style to explore some of the just loaded styles.  For example under Line Symbols there are the 
various standard FGDC lines used to mark various contacts, etc.  Under Marker Symbols there are 
other symbols we will use for Dips, etc.  Unfortunately, since we can't install the proper USGS 
geology fonts, some of these will use rather random symbols from the Wingdings  set.  We will fix the 
one symbol we actually care about for this excercise.

In the Style Manager window double click on the FGDC_GSC_20100414.style line, navigate to 
Marker Symbols in the left panel, and in the right panel scroll to and double click on 06.02 which 
should be the dip ("T shaped") symbol.  Instead of that, some strange circle-with-ears, from the 
Wingdings set, will be visible.    In the Fonts field scroll down till you find 
ESRI Geology USGS 95-525, which IS a font that was installed as part of ArcGIS.  In the 
Unicode box type 111, the code number for the dip symbol.  You should now see the "T shaped" 
symbol.  Finally, change to color to Red so the symbols will be more obvious in later steps then click 
OK.

We will change two other symbols -- those used to decorate the anticline line.  Within the above FGDC 
style navigate to Line Symbols and double click on 5.01.03, the  symbol for an exposed anticline 
whose location is slightly uncertain.  In a small Layers panel on the right within the 
Symbol Property Editor window you should see two lines, the upper one decorated by what 
should have been the outward arrows marking an anticline but probably will instead show a small 
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box -- again another bad choice taken from the Wingdings font set.  Click on the Symbol button 
which should be visible, then in the new window which appears, double click on the Edit Symbol.  
Once again select the ESRI Geology USGS 95-525 font and this time in the Unicode box, enter 
70, which should give the correct set of outward directed arrows.  Click OK to close two successive 
windows which should take you back to the list of Line Symbols.  Repeat the above steps to change 
the symbol for line type 5.01.07, a concealed anticline, to again be the outward directed arrows (# 70) 
instead of the Wingding box.  Note that the anticline line itself will be drawn as long dashes for the 
exposed anticline 5.01.03, but with short dashed for the concealed one 5.01.07.  (An exposed anticline 
with location well constrained is drawn as symbol 5.01.01, with a solid line.)  Finally close the 
Style Manager.

Next open the ArcMap Toolbox and right click to add the GeMS_ToolsArc105.tbx file (in place of 
the older one described below) from within the GeMS directory which you just unzipped.   For the 
ESB1006 machines which have ArcGIS 10.5 installed, be sure to add the 105 version, not the 10 
version.  Finally, add the RRHToolbox.tbx file which is located in the rrh_resources directory.

Skip the rest of the original USGS Setup instructions described below.

Setup
It is codvediedt to tave additodal ,esos,ces id  os, ,,cGI" idstallatod. Idstall tte followidh sets of files  
all available id tte Resources folde, of tte cos,se disk:

USGS Symbols.style                      I ,ecoppedd ttis file be llaced id ArcGIS\DesktopNN.n\Styles

GSC_FGDC-style                          "ee codtedts of ttis folde,. Idstall FGDC_GSC_20100414.style 

idto ArcGIS\DesktopNN.n\Styles. Idstall 5 T,seT le fodts  (*.t) 
b  ,ihtt-clickidh od eact add selectdh Install.

NCGMP09v1.1-Tools3_arc10.1    Col  tte edt,e di,ecto,  to  le,tals   \ArcGIS\DesktopNN.n\
NCGMP09v1.1-Tools3_arc10.1  bst cad be ad wte,e. 

Exercise 1. Digitize 1:100K-scale geologic map of the Purcell Mtn, WA 7.5' 
quadrangle
We sta,t witt Wastidhtod Divisiod of Geoloh  add Ea,tt  esos,ces Oled-file  elo,t 87-1 6 b  Hadk 
"ctasse. Yos will deed tte followidh sos,ce pate,ials  all available id tte  esos,ces folde, of ttis 
exe,cise:

ContactsAndFaults10024K.lyr ArcMap lyr fll  le  p for digitiiig 1:10024K  call liilwork

DMU_export.dbf Prlparld DMU eabll ii dba l formae, for impore iieo yo r 
Dl criptoiOfMapUiie  eabll

PurcellMtn.png                              crlli cape rl of pare of WaDGER OFR87-16

The above map is very hard to read in places.  I've created a slightly modified duplicate, with 
certain critical features highlighted in red.  Use this PurcellMtnRRH.png file in place of the 
above.

PurcellMtnRRH.png Modified sc,eed calts,e of la,t of WaDGE  OF 87-1 6

wa_ger_ofr87_16_ plt1.pdf    map  hlle of WaDGER OFR87-16 ii pdf formae

wa_ger_ofr87_16_text.pdf elxe  of WaDGER OFR87-16 ii pdf formae

Yos will c,eate tte followidh:
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PurcellMtn.gdb ai NCGMP09-formae glodaeaba l

PurcellMtn-TopologyReport.html o ep e of TopologyChlck eool

PurcellMtn-Validation.html  o ep e of ValidaelDaeaba l eool

, lahe-siie lale, pal pade f,op PurcellMtn.gdb  scale 1 :1 00K  ssidh FGDC s pbols  witt 
palsdit colo,s hived id PurcellMtnDMU.dbf

We've already done the following step 0 as part of the above setup.
0.  Start ArcMap and install the NCGMP09 toolbox

"ta,t ,,cMal. Wted ofe,ed ad existdh l,oject  CANCEL to sta,t witt ad eplt  pal coplositod. Oled 
tte ArcToolbox widdow.  ihtt-click od ad eplt  la,t of tte ArcToolbox widdow add select Add 
Toolbox... Id tte Add Toolbox widdow ttat oleds  davihate to  os, NCGMP09v1.1-Tools3_arc10.1 
di,ecto,  add select NCGMP09v1.1_Toolbox3_Arc10.1.tbx. < ihtt-click> ahaid od ad eplt  la,t of tte 
ArcToolbox widdow add Save Settings > To Default.
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1.  Make an empty GeMS NCGMP09 geodatabase specific to this project and add map tics and 
map boundary

"ta,t ,,cMal if it is dot al,ead  oled. Oled tte ArcToolbox widdow. 

,.  sd tte GeMS Tools for Arc10.5 2018-03-04 NCGMP09 Tools for Arc10 > Create New Database 
sc,ilt to pake ad eplt  heodatabase  (In the following I won't bother editing the text to show 
the new name of the toolbox.  Just  assume that substitution.)

a. Make a dew folde, fo,  os, ostlst wo,kslace. I ,ecoppedd a locatod ssct as c:\
arcdata\PurcellMtn or c:\users\<sse,dape>\Documents\PurcellMtn.
(For our class, select an exercise_12 folder on your H: drive.)

b. Nape tte dew heodatabase PurcellMtn.gdb. 
c. "et tte l,ojectod to Projected Coordinate Systems > StatePlane > NAD83 (USFeet) > 

Washington North FIPS 4601. We ctoose ttis l,ojectod to patct tte lida, data we will 
sse late,.  Thi  i  ioe ehl projlctoi of ehl  o rcl map. Why i  ie OK eo do ehi ?
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d. Make oltodal feats,e classes Geolohiciides   add  O,iedtatodPoidts  add 
MalUditPoidts.
Note ttat id GeM" sdde, Oltodal feats,e classes tte  do lodhe, list MalUditPoidts.  I'll 
desc,ibe ad alte,date wa  to taddle ttis late,. 

e. Yos cad edable edit t,ackidh—o, dot. Dod't add fields fo, ca,toh,altic ,el,esedtatods. 
Cteck ",dd iTYPE add PTTYPE". OK.   (Yos pa  deed to sc,oll dowd id tte widdow witt 
tte oste, sc,oll ba, to see ttese oltods.)

B.  sd tte NCGMP09 Tools for Arc10 > MapOutline sc,ilt.  
a. "E co,de, of Ps,cell Mtd 7.5' qsad is at 46º30' N  1 21 º45' W.  Noel ehae wl e loigie dl  arl 

ilgatil. SE loigie dl cai bl lielrld a  -121.75 or -121 45 (dlgrll  mii el  or dlcimal 
dlgrll ). SE late dl cai bl lielrld a  46 30 or 46.5.   (Note tte widtt add teihtt stosld 
al,ead  be set to tte defaslt 7.5'  .)

b. ieave IsNAD27 ctecked. (Why?) 
Tte ,easod we stosld leave IsNAD27 ctecked (alttosht tte l,ovided ldh ipahe doesd't 
,eall  l,ovide edosht idfo,patod to kdow) is ttat ttis ldh ipahe is scadded f,op a lale, 
pal wte,e tte lattsde add lodhitsde lides add otte, coo,didates we,e pa,ked ssidh tte 
N,D 1 927 coo,didate s step.  If we tad tte fsll pal we wosld see ttat N,Dxx idfo,patod 
id tte "pal colla," text.  Wted heo,efe,edcidh we deed to hive coo,didates ttat patct 
wtateve, s step was ssed id o,ihidall  pa,kidh tte feats,es od tte pal.  Wtile id a stel 
below we set tte OUTPUT coo,didates to sse a N,D83 state llade  ,,cMal deeds to kdow 
tte co,,ect INPUT coo,didates ,efe,edce ssed od tte pal  add ttat is N,D27.  ,,cMal will 
codve,t tte sc,eed coo,didates to tte ostlst datsp add l,ojectod as we d,aw add dihitie 
feats,es.  Tte locatod of tte sape dopidal (iodhitsde iattsde) loidt is actsall  abost 
300 ft dife,edt id N,D83 vs. N,D27 so if we edte,ed tte w,odh N,D wted Geo,efe,edcidh 
based od tte pa,ked (iodhitsde  iattsde)  tted all a,e coo,didates wosld be of b  ttat 
300 ft.

I actsall  dihitied tte feats,es add hede,ated tte stalefile id  GI".  If idte,ested  see tte 
dotes at tte edd abost tow to heo,efe,edce add dihitie id  GI".

c. Tic slacidh cad be set to 7.5 pidstes o, left at 2.5 pidstes.
d. Use  os, dewl -c,eated PurcellMtn.gdb as tte ostlst heodatabase. 
e. "et ostlst coo,didate s step to Projected Coordinate Systems > StatePlane > NAD83 

(USFeet) > Washington North FIPS 4601. 
 Yos pa  also deed to set tte sc,atct wo,kslace to sope di,ecto,  fo, wtict  os actsall  
tave w,ite le,pissiod.  Fo, exaplle c,eate ad exe,cise_1 2_sc,atct di,ecto,  od H: add set it 
to ttat. 

f. OK.
h. iook at tte cataloh fo,  os, dew heodatabase. Yos stosld see feats,e classes MalOstlide 

add tcs at tte tol level.    
t. ,dd tte tcs (add ostlide) feats,e class(s) to  os, pal coplositod.   (Ode wa  to do ttis is 

to sse tte Catalog ladel  l,obabl  od tte ,ihtt  add davihate to  os, dew database add 
click tte + sihd to oled it.  Tted d,ah tte MapOutline add tte tic edt,ies idto tte 
Table of Contents ladel od tte left. 

C. Save the map compositoo to your PurcellMto workspace as PurcellMto.mxd. 
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2.  Georegister scanned map image

If yo  hail ioe complleld  elp 1, makl a ilw workiig foldlr, copy ehl coielie  of foldlr Exercise1-
AutomateAnalogMap\2-GeoregisterScan iieo ehi  foldlr, aid do bll-click oi 2PurcellMtn.mxd eo  eare 
ArcMap. 

,. Col  file PurcellMtnRRH.png f,op tte Resources 
di,ecto,  to  os, wo,kidh folde,. 

B. ,dd PurcellMtn.png to tte pal coplositod. Yos 
stosld het a wa,didh pessahe abost pissidh 
slatal ,efe,edce idfo,patod. OK.  "ave! (Do 
allow it to bsild l ,apids wted it asks.)

C. Go to Customize > Toolbars add  
Georeferencing. Snapping stosld also be 
ctecked.

D. Edss,e ttat Ps,cellMtd.ldh stows id file widdow 
od tte Georeferencing tool ba,. Tal tte 
Georeferencing d,oldowd add select Fit to 
Display. Cteck Auto Adjust also.

E. ,dd lidks fo, tte 4 co,de, tcs. Thl tc  arl hard eo  ll. Thl lowlr tc  arl markld by ehl 
iielr lctoi of half-lligeh ilrtcal bar  wieh ehl map margii aid arl ii idl ehl map bo idary. 
Thl SE corilr (j  e aboil 45' oi lowlr righe of map imagl) will bl la il e eo fid aid add fr e. 
Thl  pplr tc  arl f ll cro  l  +

i. Snapping Use Snapping stosld be ctecked. 

ii. Click od tte Add Control Point bstod od tte Georeferencing toolba,

iii. Zoop idto a tc id tte pal ipahe. 

iv. Click od tte tc locatod id tte pal ipahe. 

v. Zoop ost if deed be. Click od tte co,,esloddidh tc loidt s pbol. 

vi.  eleat fo, ,epaididh tcs. 

F. Cteck ,esidsals od tte lidk table (View Link Table bstod od tte Georeferencing toolba,). 
Becasse we a,e fiidh 4 loidts—odl  1  loidt of ,edsddadc —tte ,esidsals stosld be excelledt 
(less ttad 1 0 ft  o, 0.03 pp at 1 :1 00 000 pal scale). 

G. If  os a,e satsfied witt  os, ,esslts  ho back to Georeferencing d,oldowd add click Update 
Georeferencing. Ttis will w,ite a wo,ld file (PurcellMtn.pgwx) ttat desc,ibes tte t,adsfo,patod 
f,op ipahe coo,didates to pal coo,didates add allows ,,cMal to llace tte ipahe id tte co,,ect 
llace ad  tpe tte ipahe is loaded idto a data f,ape witt tte co,,ect coo,didate s step. 

H. Disable tte ,dd Codt,ol Poidt tool b  clickidh od adotte, icod  le,tals tte Select Elements 
Tool. Ts,d tte Geo,efe,edcidh toolba, of: Customize > Toolbars > Georeferencing.

I. Save (floppy-disk symool  your map compositoo. 

3.  Setup for digitizing 

If yo  hail ioe complleld  elp 2, makl a ilw workiig foldlr, copy ehl coielie  of foldlr Exercise1-
AutomateAnalogMap\3-SetupForDigitizing iieo ehi  foldlr, aid do bll-click oi 3PurcellMtn.mxd eo 
 eare ArcMap. 

,. Do  os tave tte decessa,  toolba,s? I sssall  wo,k witt  Advanced Editing  Editor  Snapping  
Standard, Tools  add Topology  edabled
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B. ioad tte MalOstlide  os pade idto tte Codtacts,ddFaslts feats,e class. 
i. Oled tte Catalog widdow  davihate to PurcellMtn.gdb/GeologicMap io your curreot 

workspace  ,ihtt click od ContactsAndFaults  add LoadLoad Data...  Tte Simple Data 
Loader will oled. 

ii. Click od tte folde, s pbol (o, click od Next id sope ,,cMal ve,siods tted click od tte 
folde, s pbol) to oled tte Open GeoDatabase widdow add davihate to PurcellMtn.gdb 
io your curreot workspace add select MapOutline. Click Open  Add  Next>  Next>  
Next>  Next>  add Finish to load tte data id MapOutline idto tte ContactsAndFaults 
feats,e class. 

C. ,dd Codtacts,ddFaslts to tte pal coplositod. 
Oil of ehl challligl  ii workiig wieh ehl NCGMP09  chlma i  ehae mo e liil  hail m ltpll 
attrib el . ContactsAndFaults100K24K.lyr  le   p a fo r-fold iilw of Coieace AidFa le ,   ch 
ehae attrib el  LTYPE (optoial, ioe rlq irld by ehl NCGMP09  chlma), Exi eliclCoifdlicl, 
IdliteyCoifdlicl, aid LocatoiCoifdliclMlelr  arl all  ymboliild,  o ehae yo  cai  ll whae 
ehl ial l  of ehl l attrib el  arl. ContactsAndFaults100K24K.lyr al o proiidl  a  le of 
elmplael  ehae—whli a elmplael i   lllceld aid a liil i  crlaeld— le appropriael ial l  for 
ehl l attrib el  aid ehl attrib el Typl. 

i. Click tte Add Data bstod  davihate to tte Resources folde, id tte cos,se CD  add select 
ContactsAndFaults100K24K.lyr. Add. 

ii. Id tte Table of Contents  exladd Codtacts,ddFaslts1 00K24K if decessa, .  ihtt-click od 
iTYPE    pove dowd to Data  add select Repair Data Source...  "et tte data sos,ce to 
PurcellMtn.gdb/GeologicMap/ContactsAndFaults io your curreot workspace. Ttis stosld 
also fix data sos,ces fo, ssbla e,s ExistedceCodfidedce  Idedtt Codfidedce  add 
iocatodCodfidedceMete,s.  Yo   ho ld iow  ll a rld liil ehae i  ehl bo idary of ehl 
P rclll Mo ieaii 7.5-q adraigll.    (It's blse id p  dislla .)

,t ttis loidt ,atte, ttad addidh data padsall   we will actsall  load sope data I've 
al,ead  dihitied.  Oled tte RRHToolbox add dosble click AppendFeatures  wtict I 
tave colied f,op tte old E" I toolbox.  Fo, Original Feature Class  select  
rrh_resources/contacts_FIPS4601.shp .  (Do not sse tte 
contacts_no_gaps_fips4601.shp file.  I'll exllaid ttat file late,.)  "kil tte select 
Features oltod.  Fo, Project Features Class select tte ContactsAndFaults 
elepedt wittid os, paid Geological Map.  ,fte,  os ,sd ttis  os stosld be able to 
see post of tte codtacts added to tte pal alttosht  os pa  deed to popedta,il  ts,d 
of tte dislla  of tte ldh file to pake ttep visible.  (Tte l,evioss stels ssidh tte 
Codtacts,ddFaslts24K.l , file set sl defaslt st les wtict a,e a litle ta,d to see.)    
Besides codtacts  we also tave ode faslt wtict sela,ates dife,edt sdits add it deeds to 
also be added to to l,ole,l  defide all tte exloss,es.   eleat tte above stels excelt 
sse Fault_FIPS4601.shp ,atte, ttad Constats_FIPS4601.shp .

Tte,e a,e jsst a few pido, edits  os will deed to do below to copllete ttese.  Id a few 
slots I've left delibe,ate e,,o,s (pedtoded below) wtict  os will deed to fix.  Tte 
contacts_no_gaps_fips4601.shp file pedtoded above al,ead  tas ttose pistakes 
fixed  bst dod't sse it sdless sopettidh hoes w,odh witt fixidh tte dihitiidh pistakes 
 os,self  as desc,ibed below.)

D. Tal tte Snappingd,oldowd add edss,e Use Snapping is ctecked. Intersection Snapping  
Midpoint Snapping  add Tangent Snapping stosld all be edabled.  (Fo, sope otte, wo,k  os 
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pa  wadt Midpoint Snapping add Tangent Snapping edabled  bst we wod't deed ttep 
te,e.)

E. Oltodal: edable Snap To Sketch. 
If yo  b ild polygoi  ii b lk,   iig ehl NCGMP09 eoolbox Makl Polygoi   cripe, ie i  coiiliilie 
eo bl abll eo digitil  mall polygoi  a  a  iigll arc—ehae i , eo  iap ehl lidpoiie of ai arc eo ie  
owi  eare poiie. Thi  i  “Siap eo Sklech”. 
If yo  b ild polygoi  pilclmlal,   iig ehl Coi er ce Polygoi  eool oi ehl Adiaicld Editig 
eoolbar, ie may bl  idl irabll eo hail  iigll-arc polygoi , a  lilry tml yo  laelr b ild ai 
adjoiiiig polygoi,   iig ehl  harld bo idiig arc, yo  will crlael a copy of ehl iiital polygoi 
which m  e bl dllleld.  
Yos psst tave ad actve edit sessiod to edable Snap To Sketch. Id Table Of Contents  ,ihtt-click 
od iTYPE (sdde, Codtacts,ddFaslts1 00K)  sc,oll dowd to Edit Features  add click od Start 
Editing. Tted tal tte Snappingd,oldowd add click Snap To Sketch. 
Tte ode feats,e  os will deed to co,,ect is tte closed codtos, labeled TiD dea, tte cedte, of tte 
pal -- jsst to tte west of tte ,dtclide axis.  If  os ioop id od it  od its easte,d edd  os will see 
ttat tte codtact lide does dot qsite close as it stosld.  (,d sdclosed codtos, will casse l,obleps 
late,  as tte idte,io, TiD exloss,e is dot fsll  sela,ated f,op tte ss,,osddidh Tva2 exloss,e.  To 
fix ttis  sta,t editdh tte LTYPE la e,  click od tte Edit Ve,tces tool  abost 7 toolba, icods to tte 
,ihtt of tte Edito, bstod.  ,s a pessahe box will tell  os  click od a sidhle feats,e (id ttis case 
tte alpost-closed codtos,) to sta,t editdh it.  Dosble click od it to stow tte iddividsal ve,tces 
pakidh sl tte codtact.  Tted click add d,ah ode ve,tex at tte edd of tte alpost-lool towa,ds 
tte otte, oled edd ve,tex.  Yos stosld see tte posse sdal to ttat otte, ve,tex wted it hets 
close edosht.  (We do deed tte sta,t add edd to be exactl  coidcidedt  wtict is wtat tte 
sdallidh l,odsces.)   elease tte posse to fidist ttat ve,tex pove.  If  os deed to add a coslle 
po,e ve,tces to clead sl tte stale of tte lide   os cad ,ihtt click od a sehpedt add select ttat 
oltod  tted pove tte dewl  c,eated ve,tex to a hood locatod.  Wted fidisted  ts,d of editdh 
add wted it asks  OK savidh tte ,esslt.

Wte,e ode codtact idte,sects adotte, I tave llaced ve,tces at tte idte,sectod  add tave t,ied 
to sse sipila, sdallidh tectdiqses to pake ss,e all tt,ee codtact lides idte,sect exactl  at ttat 
"t,ille-jsdctod" ve,tex.  Tte,e a,e sope otte, t,icks wted dihitiidh codtacts wtict will be 
iplo,ted idto GeM"  add I discsss ttose b,ief  id tte  GI" sectod at tte edd.

We'll l,oceed assspidh tte,e a,e do "tololoh " e,,o,s id tte codtacts  add tte  all copbided to 
divide tte a,ea sl idto well defided lol hods.  Howeve, id a late, stel we will cteck ttat  add 
pa  deed to ,ets,d add pake sope fidal edits if tte,e a,e ad  l,obleps.

Id ttis sopewtat sipllified exe,cise (alttosht it is al,ead  po,e copllicated ttat I'd like) we'll 
actsall  edd sl witt a pal wtict stll tas sope "sdiplo,tadt" tololoh  e,,o,s becasse of 
lipitatods id tte GeM" abilit  to iplo,t codtacts.  We'll ihdo,e ttose fo, dow alttosht id a 
l,ofessiodal pal  os wosld l,obabl  deed to pake fs,tte, edits to add,ess ttep.

,t ttis stahe we a,e alpost ,ead  to t,  ,sddidh Make Pol hods to ts,d os, codtacts idto 
lol hods.

Howeve, befo,e doidh ttat we'll c,eate a MalUditPoidts la e, wtict cad be ssed to label tte 
lol hods.  Tte old NCGMP09 toolset sse to c,eate a la e, of ttis dape  wtict is ssefsl fo, 
labelidh tte dife,edt lol hods.  Tte  tave ,epoved it id GeM" bst I fidd it ssefsl edosht ttat 
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I've c,eates a MalUditPoidts "talefile padsall .  Howeve, fo, tte GeM" tool to sse it  we psst 
fi,st codve,t it idto a ia e, id tte pal Geodatabase.  T, idh to sse it di,ectl  as a stalefile 
casses e,,o,s id tte U"G" code.   I tave l,ovided tte file as 
rrh_resources/mapunitpoints_fips4601.shp.  To codve,t it idto a heodatabase la e, 
,ihtt click od ttis file id tte Catalog ladel add select Export tted 
To Geodatabase (single) .  Id tte dialoh wtict allea,s ttis stale file stosld al,ead  be 
selected as Input Features.  Id tte dext lide click od tte folde, icod add set tte 
Output Location to GeologicMap.  Id tte dext lide  Output Feature Class  t le id tte 
dape MapUnitPoints.  ieave tte Expression lide bladk.  Id tte Field Map wtict stosld 
codtaid a list of all tte dapes of tte idlst colspds  we deed to pake ode adjsstpedt becasse of 
dife,edces betweed stalefiles add heodatabase la e,s.  Colspd dapes id stalefiles a,e lipited 
to 1 0 cta,acte,s add so tave beed t,sdcated f,op tte dapes ttat GeM" wadts.  Fo, tte 
followidh edt,  ,ihtt click  select Rename  add ctadhe tte sto,teded dape to tte l,ole, fsll 
dape:

Short Name Full Name
IdentityCo IdentityConfidence

Click OK add afte, it fidistes  os stosld see tte MapUnitPoints id tte Table of Contents 
(ToC) add visible od tte pal.  Dosble click od it id tte ToC to b,idh sl tte 
Layer Properties widdow.  "elect tte Labels tab add cteck tte box 
Label features in this layer.  If tte Label Field is dot al,ead  set to MapUnit (tte fi,st 
colspd)  set it to ttat.  Ctadhe to colo, to sopettidh obvioss like  ed add le,tals idc,ease tte 
siie of tte fodt (1 2 loidts is sssall  hood).  Yos stosld dow see bott tte loidts add tte 
MapUnit labels od tte pal.  ,fte, late, stels tte lol hods c,eated will tave ttei, owd labels 
add we'll ts,d of dislla  of ttese loidts  bst fo, dow ttis l,ovides a cteck ttat tte sdits a,e 
l,ole,l  idedtfied.

Tte dext stel will be to ,sd tte Make Polygons tool wittid tte GeMS toolbox bst fi,st  id 
case sopettidh hoes w,odh (fo, exaplle  os fidd codtacts ttat dod't peet co,,ectl )  to sta,t 
ttis dext stel ove,  do NOT delete tte MapUnitPoly la e, as ttat wosld fo,ce  os to ho all tte 
wa  back to ,sddidh Create Database.  Idstead  if  os deed to do tte followidh stel ove,  
oled tte MapUnitPoly at,ibste table  edable editdh  delete all tte feats,es  tted edd editdh  
savidh tte ,esslt.  Next  id tte Catalog ladel  delete ad  dew la e,s c,eated ds,idh a failed 
ateplt.  Ttose cosld idclsde va,ioss error_xxx la e,s (discsssed below)  o, va,ioss 
center_xxx la e,s wtict a,e teplo,a,il  c,eated b  tte tool add cleaded sl wted it 
ssccessfsll  exits.

To ,sd  Make Polygons fi,st  dosble cteck ttat tte MapUnitPolys la e, does not allea, id 
tte Table of Contents  as ttat cad casse e,,o,s id tte tool.  ,lso  pake ss,e  os've edited 
tte sc,ilt as desc,ibed above id setsl  to fix tte bsh wtict casses it to fail to l,ole,l  add 
labels.  Dosble click od Make Polygons id tte GeM" Toolbox to ,sd tte tool.   Id tte dialoh 
widdow wtict allea,s  fo, tte Input Feature dataset select PurcellMtn.gdb\
Geological Map.   Fo, Label points feature class (optional) select tte 
MapUnitPoints  la e, id tte pal heodatabase.  Fo, ttis idital ,sd dod't botte, cteckidh 
Save old MapUnitPolys alttosht  os pihtt wadt to sse ttat od ssbseqsedt ,sds  id case 
sopettidh hoes w,odh.   ,fte, ,sddidh fo, a coslle pidstes tte loh stosld stow:
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1  pslt-labeled lol s
1 1  psltlle  codfictdh  label loidts
1 0 sdlabeled lol s

We'll see ttese ,el,esedt lotedtal e,,o,s  alttosht dot se,ioss odes.  Close tte  
Make Polygons dialoh widdow.

Id tte Catalog ladel sdde, GeologicMap  os stosld dow see tte followidh dew la e,s wtict 
let  os diahdose ad  l,obleps wtict occs,,ed ds,idh Make Polygons:

edit_ChangedPolys
errors_multilabelPolys
errors_multilabels
errors_unlabeledPolys

D,ah errors_multilabelPolys f,op tte Catalog to tte Table of Contents (ToC) to 
see wtict id fact tave psltlle labels.  Oledidh tte at,ibste table actsall  stows do edt,ies.  
Tte "1 " qsoted above is alla,edtl  sope idcodsistedc  id tow GeM" cosdts ttese "lol hods".  
We'll see below tte "lol hod" it was l,obabl  ,efe,,idh to is sope copbidatod of tte dife,edt 
exloss,es ostside tte pal ostlide wtict a,e NOT coplletel  sela,ated b  ad  codtacts.  If  os 
did tave eitte, two label loidts wittid tte sape lol hod  o, le,tals po,e likel   a hal id tte 
codtacts wtict left two idtedded lol hods coddected  ttat ttat lol hod wosld be tihtlihtted 
add stow sl id tte feats,e at,ibste table.  Odce dode witt ttis stel  ,ihtt click od 
e,,o,s_psltlabelPol s id tte ToC add ,epove it.

D,ah errors_unlabeledPolys f,op tte Catalog to tte Table of Contents.  Yos stosld 
see 3 lol hods od tte left  6 od tte ,ihtt  add ode td  ode at tte ve,  botop  all jsst ostside 
tte ostlide.  (Yos pa  deed to teplo,a,il  ts,d of tte dislla  of tte sdde,l idh ldh ipahe.)  
Ttose 9 lol hods we,e id fact all labeled  witt MapUnitPoints wittid ttat exloss,e bst idside 
tte ostlide.  Howeve, tte pal ostlide tas cst tte lol hods ala,t add "o,ltaded" tte lo,tods 
ttat lie ostside tte ostlide.  We'll see tow to avoid ttis l,oblep late,  bst it does id fact 
tihtlihtt tte deed fo, llacidh MapUnitPoints id tte ,ihtt locatod:

1 )  MapUnitPoints to be efectve psst dot odl  be id tte ,ihtt sdit  bst psst be idside 
tte pal ostlide.

2)  If  os tave a sdit exloss,e wtict is coddected ostside tte ostlide bst wtict will be 
sela,ated idto iddividsal exloss,es b  tte ostlide  tted  os deed to add sela,ate 
MapUnitPoints id eact of ttose sela,ated exloss,es.  Fo, exaplle id os, pal tte Toh 
exloss,e occslies post of tte do,tte,d bosdda,   add extedds a,osdd add lokes idto tte 
easte,d bosdda,  id a spall "ledidssla".  Besides tte o,ihidal MapUnitPoint labelidh tte 
do,tte,d ,ehiod  I tad to tad a secodd MapUnitPoint to label ttat spall "ledidssla" stckidh 
idto tte ostlide f,op tte east.  Otte,wise ttat "ledidssla"  cst of f,op tte paid do,tte,d Toh 
,ehiod b  tte pal ostlide  wosld tave beed sdlabeled.

Wted dode witt ttis stel ,ihtt click od errors_unlabeledPolys id tte ToC add ,epove it.

Next d,ah errors_multilabelPolys f,op tte Catalog to tte ToC.  Ttis stows all tte 
lol hods wtict tave po,e ttad ode label loidt idside.  Id fact  deslite tte wa,didh pessahe 
hived b  tte Make Polygon tool  tte,e a,e dot ad  ssct lol hods id os, pal.  Yos cad codfi,p 
ttis b  oledidh tte at,ibste table add cteckidh ttat it is eplt .   epove ttis la e, f,op tte ToC 
odce dode.
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Fidall   d,ah errors_multilabels f,op tte Catalog to tte Table of Contents.  Ttis 
stows all tte label loidts wte,e po,e ttad ode seeps to ,eside id a lol hod.  (Be ss,e to ts,d 
of tte dislla  of tics add le,tals MapUnitPoints as ttose cad be codfssed witt os, loidts.) 
Id ttis la,tcsla, case a dspbe, of loidts a,e stowd bst tte  loidts all co,,eslodd to labels I 
defided fo, sdit exloss,es ostside tte pal ostlide.  Becasse we taved't c,eated a "oste, 
ostlide" to defide tte oste, edhe of tte origiial  pal  ttese exloss,es coddect tohette, 
tt,osht tte ,ehiod ostside ttat o,ihidal pal.  Ttis a,ea doesd't stow sl id tte above 
errors_multilabelPolys sidce it ,eall  isd't codside,ed a t,se lol hod alttosht le,tals 
ttat is wtat tte Make Polygons tool is ,elo,tdh wted it sa s tte,e is ode "Msltlabel-lol ".  
Tte loidts te,e a,e dot ,eall  e,,o,s  bst tte  tave codfssed tte GeM" tool.  "opetpes  os will 
see additodal label loidts wtict  os did dot c,eate padsall .  If  os ,sd Make Polygons po,e 
ttad odce  o,  os padsall  edit tte MapUnitPolys at,ibste table to edte, MapUnit valses tte 
sc,ilt c,eates its owd teplo,a,  label loidts.  If ttose labels hive MapUnit valses wtict codfict 
witt tte odes id  os, MapUnitPoints tted bott loidts a,e stowd as psltlabels.  

Id tte stels above I tad  os ,epove tte la e,s f,op tte ToC wted dode.  Tte actsal data stll 
exists as stowd id tte Catalog ladel.  If  os ,eall  dod't deed ttese error la e,s ad po,e  
tted  os cad ,ihtt click od ttep id tte Catalog ladel add actsall  Delete ttep. 

Note ttat id ,eal wo,k Make Polygons will post likel  ,elo,t pad  po,e e,,o,s ttad 
stowd above.  Misllaced labels o, slihtt hals id codtacts add faslts wtict ipl,ole,l  
leave dife,edt sdits coddected sssall  stow sl at ttis stahe as sdlabeled o, psltll  
labeled lol hods.  Fo, ttis exaplle it took seve,al ite,atods to l,odsce codtacts add 
faslts wtict did l,odsce co,,ect lol hods (at least wittid tte pal ostlide).  Use tte 
l,esedce of ttose e,,o,s as a clse to fiddidh wtict codtacts  faslts  add labels tave 
l,obleps.

Wted e,,o,s occs,  fi,st edit tte feats,es id tte ContactsAndFaults24K la e,  o, 
delete ttose feats,es  edit  os, o,ihidal codtacts add faslts stalefiles  tted ,eiplo,t 
ttep.   (Wted deletdh feats,es id ContactsAndFaults24K ,epepbe, dot to delete 
tte ve,  fi,st feats,e wtict is tte tte Map Outline .)  Next  load tte MapUnitPolys 
idto tte ToC  oled tte at,ibste table  delete all tte lol hods  add tted ,epove 
MapUnitPolys f,op tte ToC.  Fidall   ,sd Make Polygons ahaid.  Ttis will l,obabl  
take seve,al ite,atods to het ,ihtt.  Id a late, stel we'll exapide otte, tools wtict will 
cteck tte tololoh  of tte codtacts add faslts.

,t ttis loidt d,ah MapUnitPolys f,op tte Catalog ladel to tte ToC so  os cad see ttose 
lol hods.  We'll fix tte dislla  l,ole,l  id a late, stel  bst fo, dow jsst so  os cad see sope 
l,oh,ess  dosble click od it id tte ToC to b,idh sl tte Properties widdow.  Id tte Symbology 
tab select Categories ,atte, ttad tte defaslt Single Symbol.  It stosld defaslt to ssidh tte 
MapUnit field as tte Value.  Click od Add All Values to pake it assihd ,addop colo,s to 
eact dife,edt MapUnit.  Id tte Display tab set tte t,adsla,edc  to 50%.  Yos stosld dow tave 
a dislla  ttat looks po,e-o,-less like a heolohical pal.

F. ,dd sope data to tte DescriptionOfMapUnits table id PurcellMtn.gdb. For dl criptoi of ehl 
DMU eabll,  ll ehl NCGMP09 doc mlieatoi oi ehl co r l CD. I hail prlparld a li e of map-
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 iie codl , map- iie labll , iaml , agl , hilrarchy codl , aid  ymbol  (color ) a   prlad hlle 
fll PurcellMtnDMU.dbf, larglly  o wl cai rladily color map- iie polygoi . 

i. Oled tte ,,cMal Catalog widdow. Navihate to PurcellMtn.gdb/DescriptionOfMapUnits 
io your curreot workspace (that is, withio PurcellMto.gdo io the Catalog paoel.  This is 
ooe of the taoles formed oy Create New Dataoase .   ihtt-click od 
Desc,iltodOfMalUdits add sc,oll dowd to Load > Load Data…  Id tte Simple Data 
Loader widdow  click od tte folde, icod to b,idh sl tte Open GeoDatabase widdow. 
Navihate to tte Resources folde, od tte cos,se CD add select PurcellMtnDMU_.dbf  
DMU_export.dbf.   Open. Add.    

ii. Next> and Next> to b,idh sl a field pallidh table (teadidhs “Ta,het Field” add 
“Matctidh "os,ce Field”) id tte Simple Data Loader widdow. Fields MalUdit  iabel  
Nape  add ,he stosld al,ead  be patcted. "c,oll dowd to Hie,a,ct Ke   click od 
<Node> id tte secodd colspd  add sc,oll dowd to select Hie,a,ct K.
(Ttese stels will iplo,t data  ssct as dapes add colo,s of sdits  f,op tte 
DMU_export.dbf  sl,eadsteet/database idto tte stadda,d GeM" 
DescriptionOfMapUnits table  so we cad avoid t lidh ttat id padsall .  Tte iplo,t 
astopatcall  patcted tte dapes of idedtcal colspds id tte table add tte dbf file  bst 
becasse tte colspd dape HierarchyKey id tte table didd't exactl  patct HierarchK 
id tte dbf file  we tad to padsall  tell it to col  codtedts f,op tte late, colspd idto tte 
fo,pe,.  Yos cad oled tte dbf file witt Excel if  os wadt to exapide its codtedts.)

iii. Next>  Next>  add Finish.
,t ttis loidt also d,ah tte DescriptionOfMapUnits table f,op tte Cataloh ladel 
idto tte ToC.
 

G. ,dd MapUnitPolys to tte pal coplositod. Click tte Add Data bstod  davihate to 
PurcellMtn.gdb/GeologicMap id  os, cs,,edt wo,kslace  add select MapUnitPolys. Add.
(We've al,ead  dode ttis.)  

H. Joid feats,e class MapUnitPolys to table DescriptionOfMapUnits. Id tte Table of Contents 
widdow  ,ihtt-click od MalUditPol s  sc,oll dowd to Joins and Relates  add Join…  Id tte Join 
Data widdow ttat oleds  “Joid at,ibstes f,op a table” (tol list-box) stosld al,ead  be selected. 

i. 1. Choose the feld…  "elect “MalUdit”.
ii. 2. Choose the table…  "elect DescriptionOfMapUnits f,op PurcellMtn.gdb io the curreot  

workspace. 
iii. 3. Choose the feld …  "elect “MalUdit”.
iv. Join Options:  "elect Keep all records
v. OK.  Yos will het ad e,,o, pessahe abost tte joided table tavidh do ,ows. ‘Tis OK. 

I. "et labelidh add pake MalUditPol s sepi-t,adsla,edt. 
i. Dosble-click od MalUditPol s to oled tte Layer Properties widdow. Tal tte Labels tab. 

Cteck Label features in this layer. Method: stosld be ”iabel all tte feats,es tte sape 
wa ”  (ttis is tte defaslt valse).  ,t Label Field:  tit tte d,ol-dowd a,,ow add sc,oll 
dowd to add select tte secodd occs,,edce of “iabel”. Ctadhe Text Symbol colo, to ,ed. 

ii. "tll id tte Layer Properties widdow  tal tte Display tab. "et Transparent: to 50%. 
(We al,ead  did ttis above.)

iii. OK. 
J. Save (floppy-disk symool  your map compositoo. 
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4.  Digitize arcs and make polygons

We've already done the equivalent of most of the steps here to enter contacts and faults.  
(However you may find the instructions useful for later work editing those features in 
ArcGIS.)  For now skip down to step D:  "Set Polygon symbolization". 

If yo  hail ioe complleld  elp 3, makl a ilw workiig foldlr, copy ehl coielie  of foldlr Exercise1-
AutomateAnalogMap\4-Digitize iieo ehi  foldlr, aid do bll-click oi 4PurcellMtn.mxd eo  eare ArcMap.  
Yo  may hail eo chaigl ehl  o rcl of P rclllMei.pig. (Ii Table of Contents, righe-click oi 
P rclllMei.pig, eap So rcl eab, click Sle Daea So rcl…, iaiigael eo yo r work pacl for  elp 3, or eo 
Exercise1-AutomateAnalogMap\3-SetupForDigitizing, aid  lllce PurcellMtn.png.)

,. Dihitie Codtacts,ddFaslts.

i.  ihtt-click od Codtacts,ddFaslts1 00k/iTYPE add davihate to EditFeatures > Start 
Editing. If feats,e tepllates do dot allea,  ho to tte ,,cMal toolba,  tal tte Editor 
d,oldowd  add davihate to EditingWindows > CreateFeatures. 

ii. Pick ad iTYPE tepllate add click awa . Dosble-click o, F2 to te,pidate a feats,e.  eleat.
iii. Save Edits (available at Editor d,oldowd) frequeotly! 

Soappiog: Yo  really waie eo li  rl ehae liil  joii prlci lly, wieho e  idlr hooe  or oilr hooe . 
Ie i  po  ibll eo fx   ch probllm  laelr,   iig iario   lditig eool , b e m ch morl lfcilie eo 
aioid ehlm from ehl gle-go. Do ehi  by (1)  ltig ehl Siappiig liiiroimlie proplrly ( ll 
ArcGIS Hllp if yo  arl  ifamiliar wieh ehi ), (2) digitiiig ae ehl appropriael  call ( o  iappiig 
work  a  yo  wi h ie eo), aid (3) eakiig a modic m of carl whill digitiiig. 
Workiog scale: If Wiidow  i  coifg rld eo proplrly rlcogiiil yo r moiieor aid moiieor 
rl ol toi, ehl  call  eaelmlie oi ehl ArcMap eoolbar will bl approximaelly corrlce. Ii glilral, I  
fid ie bl e eo work ae a  omlwhae larglr  call ehai ehl iielidld fial di play  call AND eo 
adj  e ehl workiig  call  o ehae ldgl  arl wlll dlfild (f iiy flae rl  gle  harplr a  ehly arl 
 hr ik). 
Choice of template: U l ehl workiig  call a  a g idl eo  ltig LocatoiCoifdliclMlelr , i.l., if  
a workiig  call of 1:10,000 giil  modlraelly wlll-dlfild ldgl ,  lllce 
LocatoiCoifdliclMlelr  eo bl 10.  If yo  arl digitiiig ae 1:100,000  call,  lllce 
LocatoiCoifdliclMlelr  of 100; a ial l of 30, or 10, i  clreaiily ioe appropriael. Ie’  OK  eo 
  l approximael or ro idld i mblr  for LocatoiCoifdliclMlelr . Thi  attrib el i  a rlal 
(floatig poiie) i mblr oot blca  l wl kiow ie prlci lly b e blca  l wl   l ie eo dlioel a rlal-
world q aitey. Iielglr  arl for co itig, rlal  arl for mla  riig.
Strategy: Work from yo igl e eo oldl e. Thi  la l   iappiig eo corrlce liil po itoi  aid giil  
ehl cllail e, mo e coiti o   liil  aid bl e  ymboliiatoi. Fir e crlael ehl map bo idary. Thli 
digitil Rlclie coieace  (waelr bo idaril , margii  of modifld laid aid artfcial fll). Thli 
digitil oldlr Holoclil arc  (yo ig laid lidl , yo ig all ii m, lec.). Coiti l iieo ehl pa e. 
Lioe directoo: Soml arc , partc larly low-aigll fa le , hail oriamlie  ehae lil eo oil  idl of 
ehl arc. Typically   ch oriamlie  arl oi ehl righe  idl of ehl arc, eh   wl digitil low-aigll 
fa le  wieh ehl haigiig wall eo ehl righe. Ai arc cai bl flippld aflr ehl face:  whill lditig, aid 
wieh ehl Edie Tool actil, do bll-click oi ehl arc, righe-click oi ehl arc, aid  lllce Flip. 
Maoagiog multple atrioutes: A proplrly-b ile, rllatilly  mall  le of elmplael  grlaely la l  
ehl ea k of maiagiig ehl m ltpll liil attrib el  of ehl NCGMP09  chlma. Howlilr, ie i   iliklly  
ehae aiy   abll  le of elmplael  will allow yo  eo  plcify all attrib el  of all arc . For lxampll, 
ehl elmplael  ii Coieace AidFa le 100K.lyr do ioe crlael fa le  ehae arl q lrild blca  l ehlir 
idlitey (l.g., coieace ilr    fa le, or  erikl- lip fa le ilr    iormal fa le) i   iclreaii. Nor do ehl  
elmplael   le DaeaSo rclID ial l  (wa  ehi  arc digitild from ai aialog map, iielrprleld from 
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alrial phoeograph , or walkld ii ehl flld whill crlatig a GPS eracklog?). Thiik abo e yo r map,  
b ild appropriael elmplael , haid-calc lael  oml ial l , aid   l ehl ldie-erackiig attrib el  eo 
idlitfy arc  ehae wlrl crlaeld or modifld d riig ehl  aml ldie  l  ioi aid eh   (probably hail  
a commoi daea  o rcl. 

B. Make Pol hods. Two pettods fo, c,eatdh lol hods f,op lidewo,k a,e tte NCGMP09 Make 
Polygons sc,ilt add tte ,dvadced Editdh Construct Polygons tool.
i. NCGMP09 toolbox > Make Polygons is ad edtadced w,alle, fo, tte Feats,e to Pol hod 

(Data Madahepedt) sc,ilt l,ovided witt ,,cGI". Make Polygons c,eates lol hods f,op all 
a,cs id ContactsAndFaults add labels ttese lol s witt bott a) existdh lol  at,ibstes add b) 
at,ibstes of ad  MapUnitPoints label loidts.  Make Pol hods also c,eates adcilla,  feats,e 
classes ttat idedtf  sdlabeled lol hods  lol hods witt psltlle label loidts  label loidts 
ttat a,e psltlles wittid a sidhle lol   add tte lol hods ttat bo,de, eact a,c sehpedt. Its 
scole is tte edt,e feats,e dataset. 
Yos cad sse Make Polygons to pake sdlabeled lol hods ttat  os late, select add at,ibste 
witt MalUdit  o,  os cad add loidts to feats,e class MapUnitPoints ttat  os at,ibste witt 
MalUdit  add ttese valses will be t,adsfe,,ed to tte c,eated lol hods. 

ii. Use tte Construct Polygons tool to c,eate lol hods f,op selected a,cs. ,dvadtahes of ssidh 
ttis tool a,e (a) its lipited scole add (b) its ippediac   idclsdidh feedback od dihitiidh 
qsalit . Tte l,ipa,  disadvadtahes a,e ttat (c) it is eas  to c,eate dsllicate lol hods ttat 
psst be deleted  (d) dot all codceivable lol hods will be c,eated  add (e) lol hods psst be 
labeled afte, tte  a,e c,eated; ad  label loidts a,e ihdo,ed. 

iii. I t licall  c,eate label loidts (Make Polygons pettod) o, select dewl  c,eated lol hods 
(Construct Polygons pettod) add at,ibste ttese witt MalUdit odl   leavidh all otte, 
at,ibstes dsll—excelt ttat if tte lol hod label tas a qse,  (e.h.  “Tva2?”)  I set MalUdit = 
“Tva2” add Idedtt Codfidedce = “qsestodable". I late, oled tte at,ibste table of 
MalUditPol s  select all lol s witt Idedtt Codfidedce <> “qsestodable”  add calc 
Idedtt Codfidedce of ttose lol s to be “ce,taid”.  I set iabel add " pbol valses late,. 

C. Editor Save Edits. Editor Stop Editing. 
Pick sl tte idst,sctods te,e  to set tte wa  tte MalUditPol s will be dislla ed.)

D. "et lol hod s pboliiatod. Id tte Table of Contents widdow  dosble-click od MalUditPol s to 
oled tte Layer Properties widdow. "elect tte Symbology tab. 
i. Udde, Show:  (left side of widdow)  select Categories > Match to symbols in a style
ii. "et Value Field to tte secodd occs,,edce of " pbol id d,ol-dowd list. 
iii. Match to symbols in Style—tal Browse… add davihate to add select USGS Symbols.style. 

Rlmlmblr whlrl yo  p e ie? 
iv. Click on Match Symbols. Tted click od OK.

Ttese stels set sl tte dislla  to sse slecific colo,s (add sopetpes fill late,ds) fo, slecific 
sdits.  Ttis will ,ellace tte ,addop colo,s we assihded iditall .  Fo, exaplle  dot ttat tte 
 sate,da,  sedipedt is colo,ed tte exlected  ellow.

" pboliiatod cad be set befo,e all lol hods a,e labeled. ,dd set ahaid. 

,t ttis loidt oled tte MalUditPol  at,ibste table add exapide it.  Wtile pad  colspds a,e stll 
dsll  id tte late, colspds codside,able idfo,patod tas beed added ssct as a Nape add a 
(Geolohic) ,he fo, eact MalUdit.  Tte Hie,a,ctKe  l,ovides idfo,patod abost tow tte dife,edt 
sdits wosld be o,hadiied id a lale, "Desc,iltod of Mal Udits" ladel.  Tte secodd iabel colspd 
sssall  dsllicates tte text id MalUdit bst cosld be ssed to l,ovide fadcie, fo,paidh  fo, 
exaplle ssidh heoloh  slecific fodts fo, P,ecapb,iad o, T,iassic.  Tte " pbol colspd hives 
idfo,patod abost tte colo,s ssed to dislla  eact sdit.  Tte ,,eaFillPate,d cosld hive 
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idfo,patod abost a late,d (,atte, ttad a siplle colo,) to sse id fillidh tte lol hod.

Tte followidh stel will c,eate a GeologicMap_topology la e, wtict will let ss cteck tte 
tololoh  of tte hede,ated pal.   Wted  os d,ah ttat la e, idto tte ToC (add le,tals ts,d of 
otte, codfssidh la e,s) a va,iet  of locatods will be tihtlihtted id ,ed to iddicate e,,o,s.   Fo, 
exaplle "dadhlidh codtacts" ttat jsst edd wittost coddectdh to sope otte, codtact a,e pa,ked 
b  a ,ed box. )  Howeve, all tte e,,o,s a,e id fact od o, ostside tte pal ostlide.  Wittid tte 
ostlide eve, ttidh looks OK.  We'll see late, tow to avoid ttese l,obleps.  ,haid  id ,eal wo,ld 
sse  tte tool will l,obabl  ,eveal l,obleps witt  os, codtacts o, labels wtict  os deed to fix.  

E. Make add idslect tololoh . To c,eate ad sdapbihsoss pal  add to allow ce,taid so,ts of 
qse,ies  it is iplo,tadt ttat codtact add faslt a,cs dot ove,lal  codtact add faslt a,cs dot 
idte,sect ttepselves  lol hods dot ove,lal  ttat tte,e be do hals betweed lol hods  ttat tte,e 
be do dadhlidh sdcodcealed codtacts (dadhlidh codcealed codtacts add dadhlidh faslts a,e 
t licall  OK)  add ttat all lol hod bosdda,ies a,e coidcidedt witt ad sdcodcealed codtact o, 
faslt. 
i. Cteck ttat  os do dot tave ad oled edit sessiod. 
ii. Oled ArcToolbox. Id tte ArcToolbox widdow  oled NCGMP09 Tools for Arc10. Dosble-click 

od Make Topology. Fo, Input feature dataset  davihate to add select feats,e dataset 
PurcellMtn.gdb/GeologicMap io your curreot workspace. OK. 

iii. Oled tte Cataloh widdow add davihate to Ps,cellMtd.hdb/GeolohicMal id  os, cs,,edt 
wo,kslace. ,dd GeologicMap_topology to  os, pal coplositod. Yos will be asked wtette, 
 os also wadt to add la,tcilatdh feats,e classes. ,dswe, No (tte  stosld al,ead  be 
l,esedt). 

iv. "ta,t editdh (,ihtt-click od MalUditPol s add Edit Features > Start Editing). iook at tte 
pal fo, e,,o,s  add (o,) oled tte Error Inspector widdow add cteck fo, e,,o,s. Note ttat 
,,cMal will tah dadhlidh faslt a,cs as e,,o,s  bst we accelt ttep. Yos pa  pa,k ttep as 
exceltods. Fix ad  e,,o,s ttat  os fidd.  e-validate tte tololoh .  eleat sdtl tte,e a,e do 
e,,o,s. Yo r map  ho ld hail oil daigliig fa le arc. 

F. Editor Save Edits. Editor Stop Editing. Save  os, pal coplositod. 

5.  Digitize orientation points and geologic lines

If yo  hail ioe complleld  elp 4, makl a ilw workiig foldlr, copy ehl coielie  of foldlr 
Exercise1-AutomateAnalogMap\5-DigitzeOrientationPointsAndGeologicLines iieo ehi  foldlr, aid 
do bll-click oi 5PurcellMtn.mxd eo  eare ArcMap. (Yo  may hail eo chaigl ehl  o rcl of 
P rclllMei.pig. Ii Table of Contents, righe-click oi P rclllMei.pig, eap So rcl eab, click Sle 
Daea So rcl…, iaiigael eo yo r work pacl for  elp 3, or eo Exercise1-AutomateAnalogMap\3-
SetupForDigitizing, aid  lllce PurcellMtn.png.)

We dihitied lides ssidh feats,e tepllates to set tte psltlle at,ibstes ttat cta,acte,iie NCGMP09-st le 
data. Os, sos,ce pal tas odl  ode favo, of o,iedtatod loidt (“beddidh”) add two favo,s of heolohic 
lide (“adtclide axis” add “adtclide axis  codcealed”). We will padahe wittost l,ela,ed feats,e 
tepllates—idstead  we will dihitie hede,ic loidt add lide feats,es add padsall  set tte ,elevadt 
at,ibstes.  If  os a,e dihitiidh a va,iet  of O,iedtatodPoidts T les (e.h.  beddidh  sl,ihtt beddidh  
foliatod  joidt  st,etctidh lideatod) o, Geolohiciide T les   os will l,obabl  fidd it ssefsl to c,eate a 
lalete of feats,e tepllates sipila, to ttat id Codtacts,ddFaslts1 0024K.l ,. 
Tte loidt of ttis sectod is to lea,d tow to d,aw feats,es like tte "dil iddicato, T" s pbols  add o,iedt 
ttep co,,ectod.  Jsst t,  to add a coslle  patctidh ttep to tte existdh odes od tte pal.  Id pode,d 
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wo,k we'd l,obabl  iplo,t ttis idfo,patod as a sl,eadsteet hividh dil iddicato, locatods  alodh witt 
tte ,eco,ded aiipstt add idclidatod.

,. "qsa,e  os, pal witt tte wo,ld. We do ttis to tave od-sc,eed ,otatod = heoh,altic ,otatod. ,t tte 
,,cMal paid peds  View > Data Frame Properties…  Id tte Data Frame Properties widdow  tal 
tte General tab add adjsst Rotation: sdtl tte pal is sqsa,e witt tte wo,ld. I fid ehae a ial l of 
0.75 work  for ehi  rlgioi aid map projlctoi. 

B. Wtile  os a,e at tte General tab of tte Data Frame Properties widdow  set Reference Scale: to 
1 :1 00 000. 

C. ,dd OrientationPoints add GeologicLines to  os, pal coplositod. 
i. Oled tte Catalog widdow. 
ii. Navihate to PurcellMtn.gdb/GeologicMap id  os, cs,,edt wo,kslace. Exladd tte 

GeologicMap feats,e dataset. 
iii. D,ah OrientationPoints add d,ol it idto tte Table of Codtedts widdow.  eleat witt 

GeologicLines. 
D. C,eate teplo,a,  s pboloh  fo, O,iedtatodPoidts

i. Id the Table of Contents  exladd O,iedtatodPoidts. Dosble-click od tte s pbol (l,obabl  a 
da,k-colo,ed dot) to b,idh sl tte Symbol Selector widdow. Next to Search:  tal tte ,adio 
bstod fo, “All Styles”. T le "bedding" idto tte sea,ct widdow add tit <Edte,>. "elect 
s pbol 06.02 f,op FGDC_G"C_201 0041 4.

Tte follow idst,sctods will set sl ,,cGI" so it ,otates tte dislla ed dil s pbol to patct tte 
,iipstt valse id tte at,ibste table  add labels it witt text hividh tte Idclidatod valse f,op 
tte at,ibste table.  Tte idst,sctods tted stow  os tow to sse a tool to padsall  ,otate tte 
s pbol to patct tte ode od tte pal  add ttat sipsltadeossl  ctadhes tte ,iipstt valse 
sto,ed id tte at,ibste field.
 Click od the Color:  d,oldowd add ctadhe tte colo, of tte s pbol to sopettidh tihtl  
visible like b,ihtt ,ed. OK to exit.

ii. Id tte Table of Codtedts  dosble-click od "O,iedtatodPoidts" to ssppod tte Layer 
Properties widdow. Click od tte Labels tab. Cteck "Label features in this layer”. "et Label 
Field: to Idclidatod.  "et Text Symbol colo, to patct 
 os, beddidh s pbol. Click Placement Properties...  
click tte Placement tab  add select Place label on top 
of the point. OK. 

iii. "elect tte Symbology tab id the Layer Properties 
widdow. Click od tte Advanced d,oldowd add select 
Rotation...  Click tte d,oldowd fo, Rotate Points by 
Angle in this feld: add select ",iipstt". Edss,e ttat 
Rotation Style: is Geoh,altic. OK. OK. "ave  os, .pxd 
ahaid.  
Wtile tte above ,otates tte dil s pbol  it doesd't 
,otate tte idclidatod label.  To do ttat click od tte 
Label ladel tted click od Placement Properties. 
"elect Place label at an angle specified by a field  
click od Rotation Field  select Azimuth  be ss,e 
Geographic is ctecked  tted fidall  cteck 
Place label perpendicular to the angle.
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E. Dihitie o,iedtatod loidts. 
i. Yos pa  deed to ,ihtt-click od O,iedtatodPoidts id tte Table of Contents widdow add ,e-

sta,t editdh (Edit Features Start Editing). If tte C,eate Feats,es widdow is dot available  

click Editor add davihate to Editnn Windows 䫌 Create Feat羻res. Go to tte Create 
Features widdow add select tte O,iedtatodPoidts tepllate.
Jsst add a few loidts to see tow ttis is dode -- fo, exaplle tte tt,ee dea, tte tol of tte 
pal  all wittid Tot  wtict tave dils of 45  36  add 27.  Make ss,e tte odes  os add a,e 
actsall  wittid tte Mal Ostlide.  ,t tte edd of tte followidh l,ocess tte idclidatod dspbe,s 
stosld be dislla ed dext to tte dil s pbols  bst becasse of fodt issses tte  pa  be 
ssle,losed od ttep.

ii. I fidd it qsickest to fi,st llace all beddidh loidts add tted set ttei, at,ibstes: 
a. Zoop idto tte pal. "elect tte O,iedtatodPoidts tepllate f,op the Create Features 

widdow. Click od tte cedte, of a beddidh aitsde ttat is stowd od tte pal. Ttis will 
llace ad O,iedtatodPoidts pa,ke, witt ,iipstt = 0  Idclidatod=0  add labeled witt 
Idclidatod. Go to tte dext aitsde add ,eleat sdtl  os've added loidts fo, all 

beddidh aitsdes. Editor Save Edits!
b. "elect tte Edit Tool od tte Editor toolba,. "elect a beddidh s pbol. "elect tte Rotate 

tool od tte Editor toolba,. G,ab ad edd of tte beddidh s pbol add ,otate it sdtl it is 
alihded witt tte beddidh aitsde stowd od tte pal. Go to tte Attributes widdow 
add ke  id tte idclidatod valse stowd od tte pal.  eleat sdtl all beddidh valses 

a,e set. Editor Save Edits!
c. Id tte Table of Contents  ,ihtt-click od O,iedtatodPoidts add Open Attribute Table. 

Id tte OrientationPoints widdow ttat oleds  ,ihtt-click od tte T le colspd tted 
davihate to add click Field Calculator...  "et T le = "beddidh". Tted OK to set all 
T le valses to "beddidh".  (To be po,e exllicit abost tte l,ecedidh stel  we will sse 
tte field calcslato, to po,e-o,-less easil  set all edt,ies id hived colspds of tte 
at,ibste table to ce,taid slecified valses.  Fi,st pake ss,e do ,ows (feats,es) a,e 
actsall  selected  o, odl  ttat ,ow will be ctadhed.  Yos cad sse to icod at tte slle, 
left of tte table to clea, ad  selectod.  Wittid tte ,t,ibste Table ,ihtt click od tte 
T le colspd add select Field Calcslato,.  It stosld stow a bladk ladel sdde, tte text 
T le =.  Edte, "beddidh" (witt dosble qsotes) idto ttat ladel add click OK.  Ttat will 
set all edt,ies id ttat colspd to tte st,idh "beddidh".  Use tte sape tectdiqse to set 
all edttes id tte followidh colspds to tte valses hived.  ,s la,t of tte GeM" 
stadda,d  fo, ad  idfo,patod like O,iedtatod (dil) data  we tave to slecif  tow 
accs,ate it is  add wte,e tte data cape f,op.  Id ttis case adotte, table will hive ss 
idfo,patod abost tte D,"1  ",efe,edce".   eleat fo, Plot,t"cale = 1 20000  
iocatodCodfidedceMete,s = 1 00  Idedtt Codfidedce = "ce,taid"  
O,iedtatodCodfidedceDeh,ees = 5  iocatod"os,ceID = "D,"1 "  add Data"os,ce 
O,iedtatod"os,ceID = "D,"1 ".  (Tte late, is adotte, dape ctadhe betweed 
NCGMMP09 add GeM".  Tte  tave also added a sela,ate O,iedtatod"os,ceID  id 
case tte idfo,patod od o,iedtatod copes f,op a dife,edt sos,ce ttad locatod.)  
Editor Save Edits!  Close tte at,ibste table. 

F. Dihitie heolohic lides. 
i. Go to tte Create Features widdow add select tte Geolohiciides tepllate. Od tte pal  

dihitie tte exlosed (codtdsoss) adtclide axis as ode a,c  tted tte codcealed (doted) 
adtclide axis as a secodd a,c. Note wted addidh ttese   os "HOUiD sse sdallidh so tte 
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edd of tte exlosed a,c add tte behiddidh of tte codcealed a,c lie exactl  od tte bosdda,  of 
tte codtact wtict codceals ttep.  ,lso  tte,e is a tti,d lo,tod wtict is exlosed  bst it lies 
ostside tte Mal Ostlide  so  os dod't deed to add it.

ii. Id the Table of Contents widdow  ,ihtt-click od O,iedtatodPoidts add Open Attribute Table. 
Hihtlihtt (click od left pa,hid) ode ,ow. Is ttis doted lide od tte pal? If so  t le Y idto 
IsCodcealed. O, N if dot. Edte, tte all,ol,iate valse fo, tte otte, ,ow. Fo, bott ,ows  
calcslate (i.e. set as above ssidh tte field calcslato,) T le = "anticline"  
ExistedceCodfidedce = "certain". Idedtt Codfidedce = "certain"  

iocatodCodfidedceMete,s = 200  add Data"os,ceID = ”DAS1”. Editor Save Edits! Editor 
Stop Editing. Close tte O,iedtatodPoidts at,ibste table.

Thl GlologicLiil  flae rl cla   i  a hold-all for liilar flae rl  ehae arl prl lie ii ehl rlal world—
ehae i , ehly may bl coiclalld aid ehly may hail  iclreaiiey ii ehlir po itoi, idlitey, aid 
lxi elicl—b e ehly aid ehlir kii do ioe partcipael ii ehl map eopology. If ehlrl arl a largl i mblr 
aid iariley of   ch liil  ie may bl appropriael eo crlael oil or morl additoial flae rl cla  l  for 
 oml of ehl l flae rl . Sll ehl NCGMP09 doc mlieatoi. 

Becasse we iplo,ted tte Codtact,ddFaslt data wittost seidh all tte c,itcal at,ibste idfo,patod  
we stosld do ttat dow befo,e askidh tte s step to set sl s pbols fo, tte feats,es.  Usidh tte above 
exaplles  oled tte ,t,ibste Table add b  ssidh tte Field Calcslato,  set all edt,ies id tte Type 
colspd to "contact".  Tted ctadhe tte fi,st ode to "outline" add tte last to "fault".  (Yos 
cosld dosble cteck ttese a,e tte ,ihtt to edt,ies to ctadhe b  selectdh ttep add lookidh at wtat 
feats,e is tihtlihtted id tte pal.)  Next  set all edt,ies of LocationConfidence to 50  add all 
edt,ies of ExistenceConfidence add IdentityConfidence to "certain".  ,lso set 
IsConcealed to "N" add DataSourceID to "DAS1".  We COUiD tave c,eated a 
Codtacts,ddFaslts stale file wtict codtaided ttese at,ibstes (o, at least tte 1 0 cta,acte, 
sto,teded ve,siods of ttese dapes) tted sipll  iplo,ted ttis idfo,patod alodh witt tte codtacts 
ttepselves.

6.  Add Metadata

If yo  hail ioe complleld  elp 5, makl a ilw workiig foldlr, copy ehl coielie  of foldlr 
Exercise1-AutomateAnalogMap\6-AddMetadata iieo ehi  foldlr, aid do bll-click oi 
6PurcellMtn.mxd eo  eare ArcMap. 

Tte NCGMP09 sctepa ,eqsi,es a sihdificadt idte,dal feats,e-level petadata. Yos c,eated sope of ttis 
(e.h.  valses of iocatodCodfidedceMete,s) as  os dihitied feats,es. Now add tte ,epaidde,.

,. Back sl tte heodatabase. Yos a,e hoidh to pake sihdificadt  wtolesale podificatods to tte 
heodatabase. Best to keel a col   id case  os sc,ew ttidhs sl.

i. Oled tte ArcToolbox widdow. Exladd NCGMP09 Tools for Arc10 add dosble-click Compact 
and Backup. Fo, Input Geodatabase  tal tte folde, s pbol add davihate to PurcellMtn.gdb 
io your curreot workspace. OK. 

ii. iook at  os, cs,,edt wo,kslace  eitte, witt a di,ecto,  widdow o, via tte Catalog widdow. 
Note ttat tte backsl col  of tte heodatabase. 

(,s of 201 8_04_20 I het ad e,,o, wted I t,  to c,eate tte backsl.  Jsst ihdo,e ttat fo, dow 
alttosht dot tavidh a ,eliable backsl ce,taidl  isd't ideal.  ,lla,edtl  ttis is a kdow l,oblep 
id ,,cMal wted  os t,  to do backsls ove, a detwo,k.  It seeps to wo,k ,eliabl  wted tte 
database is od a local disk.)

B. MalUditPol s  Idedtf Codfidedce=ce,taid. Yos tave l,obabl  al,ead  doted wtict lol hods tave 
sdce,taid idedttes. Yos dow deed to slecif  Idedtf Codfidedce fo, tte ,epaidde,.  Id tte Table of 

20



Contents widdow of ,,cMal  ,ihtt-click od MalUditPol s add davihate to Open Attribute Table. 
i. "elect sope ,ows.

a. ,t tte slle, left co,de, of tte Table widdow  click tte Table Options d,oldowd 
add Select by Attributes...  Id tte Select by Attributes widdow  bsild ad " i 
exl,essiod:  

1 . Method: stosld be C,eate a dew selectod (tte defaslt).
2. Dosble-click od MalUditPol s.Idedtt Codfidedce. Thl flld iaml i  

compo id blca  l MapUiiePoly  i  joiild eo Dl criptoiOfMapUiie . 
3. Click od <>. 
4. Click od Get Unique Values. 
5. Dosble-click od ‘qsestodable’. 

b. Apply. 
c. ,ll ,ows id tte MalUditPol s feats,e at,ibste table stosld be tihtlihtted excelt 

ttose witt Idedtt Codfidedce = “qsestodable”. 
Tte ,easod ttis colspd is al,ead  lolslated is ttat we iplo,ted ttese valses f,op 
tte Idedtt Co colspd of MalUditPoidts.  Gived ttat  we l,obabl  dod't ,eall  deed 
to ctadhe ttese valses  bst l,oceed witt tte followidh stels so  os sdde,stadd tow 
 os wosld do ttis if we tadd't al,ead  set ttis at,ibste.

ii. Calcslate valses.
a.  ihtt-click od tte Idedtt Codfidedce colspd teadidh add davihate to Field 

Calculator… 
b. Id tte text widdow MapUnitPolys.IdentityCOnfdence    edte, “certain”. 
c. OK. 
d. Clea, tte selectod: Table Options Clear Selection. 

e. Editor Save Edits!
Yos pa  tave dotced ttat sope ,ows id tte table dod't tave ad edt,  sdde, 
MalUdit.  Ttose a,e tte sdlabeled lol hods wtict lie ostside tte Mal Ostlide.  
We've jsst said ttat ttei, idedtt  is ce,taid  wtict is l,obabl  a codt,adictod id 
te,ps.  Bst tte ,eal solstod stosld be to ,epove ttose i,,elevadt lol hods.  We'll 
see tow to do ttat astopatcall  late,.  Fo, dow  jsst take ttis as a lessod od tte 
idcodsistedcies  os cad bsild idto  os, heolohic pal if  os a,ed't ca,efsl.

C. Calc Data"os,ceIDs. 
i. Id tte MalUditPol s at,ibste table  ,ihtt-click od tte teadidh of colspd Data"os,ceID 

(wtict is dife,edt ttad Data"os,ce)  add davihate to Field Calculator… Id tte text box 
MapUnitPolys.DataSourceID    t le “DAS1”. OK. Close tte at,ibste table. 

ii. Oled tte at,ibste table fo, ContactsAndFaults (,ihtt-click od 
Codtacts,ddFaslts1 00K/iTYPE). Calc Data"os,ceID = “DAS1”. Close tte at,ibste table.

iii. Yos tave al,ead  set DataLocatoi"os,ceIDs fo, OrientationPoints add GeologicLines. Bst  os 
cosld cteck.  Noel ehae OrilieatoiPoiie  ha  boeh OrilieatoiSo rclID aid 
DaeaSo rclLocatoiSo rclID, a  orilieatoi aid locatoi  may hail  lparael  o rcl . For 
ehi  erai criptoi, boeh  ho ld bl “DAS1”. 

iv. Editor Save Edits!
D. ,dd idfo,patod to petadata tables DataSources add Glossary.

i. Oled Cataloh widdow. Navihate to PurcellMtn.gdb io your curreot workspace. ,dd tables 
DataSources add Glossary to  os, pal coplositod. 

ii. Id tte Table Of Contents widdow  ,ihtt-click od Data"os,ces add Open. 
So far, all ehl iiformatoi ii P rclllMei.gdb ha  a  iigll  o rcl: Wa hiigeoi DGER 
Opli-fll Rlpore 87-16, by Haik Scha  l, erai cribld by yo . Yo  illd eo add ai liery eo  
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dl cribl ehi   o rcl.  
(Opli ehl eabll for lditig which crlael  a ilw row,  idlr ehl lxi tig rlflrlicl eo ehl 
FGDC.)
a. Id table Data"os,ces  id colspd Data"os,ces_ID  edte, DAS1. 

Thi  DAS1  lril  a  a liik, a  horehaid rlflrlicl, coiilctig ehl "cieatoi " ii ehl 
iario   daea eabll , aid ehl "Bibliography" ii ehi  DaeaSo rcl  eabll. 

b. Id colspd "os,ce  edte, ad all,ol,iate podificatod of tte followidh (col  add 
laste wo,ks):   Geology of the Mount Rainier quadrangle, Washington, 
compiled by Henry W. Schasse, Washington Division of Geology and Earth 
Resources Open File Report 87-16, 1987, map scale 1:100,000. Digitized 
and interpreted by Ralph Haugerud in September-October 2014.  

c. Id tte Notes field   os pihtt edte, ad all,ol,iate podificatod of tte followidh:  
Values of LocationConfidenceMeters, ExistenceConfidence, 
IdentityConfidence, and OrientationConfidenceDegrees assigned by 
Haugerud on the basis of source map scale, source map symbolization, 
and his experience. These values may not coincide with the intent of 
the author of the source map. 

d. Close Table DataSources. Editor Save Edits. 
iii. Id tte Table Of Contents widdow  ,ihtt-click od Glossa,  add Open. 

Table Glossary codtaids defiditods of tte te,ps ssed id ad NCGMP09 heodatabase. ,ll 
te,ps ssed id a T le field o, a Codfidedce field stosld be defided te,e. Wl will laelr r i  
a  cripe eo chlck ehae ehl li e of elrm  dlfild ii Glossary i  compllel. For iow, wl add a 
flw ehae wl cai rlmlmblr.   
a. Seare lditig.  Id table Glossa,   ii a ilw row, id tte Te,p colspd  edte, contact 

<,ets,d>. Codtdse to edte,  id ssccessive dew ,ows of tte Te,p colspd  fault  
bedding  anticline  certain  add questionable.  (Thl l la e ewo hail alrlady 
blli lielrld a eomatcally.)

b. We leave Glossa, _ID eplt  fo, dow. 
(For ehi  lxclrci l, doi'e ace ally  plid tml lielriig ehl followiig dlfiitoi ).

c. Yos tave seve,al ctoices fo, defiditods. Yos pa  w,ite  os, owd. Yos pa  
la,alt,ase defiditods f,op  os, favo,ite dictoda,  o, heoloh  text. O,  os pa  
la,alt,ase defiditods f,op tte ,pe,icad Geolohical Idsttste’s Glossa,  of Geoloh  
(,ecoppedded). 

Note ttat certain add questionable a,e dot defided id tte ,GI Glossa, ; tte 
best defiditod fo, ttei, peadidh id ttis codtext ttat I ap awa,e of is ttat od 
lahes 1 6-1 7 of tte FGDC Geolohic Mal " pboliiatod stadda,d (FGDC-"TD-01 3-
2006). 

d. Id adotte, docspedt  d,aft  os, defiditods. Col  add laste ttep idto tte 
all,ol,iate Defiditod field id table Glossary. 

e. Fo, eact sdiqse sos,ce of defiditods  c,eate a dew Data"os,ceID valse add edte, it 
id tte Defiditod"os,ceID field. If all defiditods tave tte sape sos,ce  all 
Defiditod"os,ceIDs will be tte sape (e.h.  DAS2). 

f. Close Table Glossary. Editor Save Edits. 
iv. Fo, eact dew valse of Defiditod"os,ceID  ttat  os c,eated id Glossary  c,eate a 

co,,esloddidh edt,  id table DataSources. Sll  elp ii, aboil. 
(For ehi  lxlrci l,  kip ehi   elp a  wlll.)

v. ,dd idfo,patod to DescriptionOfMapUnits. Id tte Table of Contents widdow  ,ihtt-click od 
Desc,iltodOfMalUdits add Open. Yos a,e hoidh to l,ovide additodal at,ibstes fo, eact 
pal sdit idedtfied id tte DMU  bst dot fo, ttose ,ows ttat co,,eslodd to DMU teadidhs.
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vi. "elect ,ows ttat co,,eslodd to pal sdits. 
a. Id tte Table widdow  tal tte Table Options d,oldowd at tte slle, left co,de, of 

tte widdow. 
b. Select By Attributes… 

c. Id tte Select By Attributes widdow  Method: stosld be C,eate a dew selectod (tte 
defaslt). Id tte list of fields below  dosble-click od “MalUdit”. Tal <>. Tal Get 
Unique Values.  Id tte list of sdiqse valses  dosble-click  ‘’.  (Thae i , ehl lmpey 
 eriig,  o io MapUiie i   plcifld. Yo  arl  lllctig all ehl row  ehae DO hail  oml 
iaml.)

d. Apply. ,ll ,ows of Desc,iltodOfMalUdits ttat tave dod-dsll valses of MalUdit 
stosld dow be tihtlihtted. 

vii. FsllNape. "ope pal-sdits  od sope pals  tave dapes like “saddstode pepbe,” ttat a,e 
dot idfo,patve sdtl  os kdow ttat ttis is tte “saddstode pepbe, of tte XYZ Fo,patod.” 
Fslldape is a field fo, sto,idh tte late,  coplosdd dape ttat pihtt be ssed id a f ost ttat 
allea,s wted a sse,’s cs,so, tove,s ove, a pal-sdit lol hod id a web dislla  of tte pal. 

a. Fo, ttis pal  FsllNape cad be tte sape as Nape.  ihtt-click od tte FsllNape 
teadidh add oled tte Field Calculator… 

b. Id tte Field Calculator widdow  id tte Fields: box  dosble-click od Nape. 
c. OK. Valses of FsllNape fo, all ,ows stosld dow be tte sape as valses of Nape. 

viii. Desc,iltod. Id a bete, wo,ld os, sos,ce-pal text wosld dot be a scadded ipahe add we 
cosld col  pal-sdit desc,iltods f,op tte sos,ce pal add laste ttep idto tte DMU table. 
Udfo,tsdatel  ttis is dot lossible

a. Oled file Resources/OCR/MapUnitDescriptions.docx id tte cos,se CD.  ead tte 
idt,odsctod od tow ttis file was c,eated.
(Do ehl followiig for j  e oil or ewo  iie ,  o yo  kiow whae lilie ally i  lxplceld.  
I'il copild ehl aboil docx fll iieo ehl maii resources dirlceory.)

b. Col  pal-sdit desc,iltods add laste idto all,ol,iate llaces id Table 
Desc,iltodOfMalUdits.

ix. Desc,iltod"os,ceID. Os, desc,iltods all cope f,op OF  87-1 6. 
a.  ihtt-click od tte Desc,iltod"os,ceID teadidh add oled tte Field Calcslato,…
b. Id tte Field Calcslato, widdow  id tte Desc,iltod"os,ceID box  t le “D,"1 ”. OK.
c. Close Table DescriptionOfMapUnits. 

d. Editor Save Edits.
x. Gede,aliittoloh 

a. Oled tte NCGMP09 docspedtatod (Documentation/ usgs_of2010-
1335_NCGMP09.pdf) add tte text fo, OF  87-1 6 (Resources/ 
wa_ger_ofr87_16_text.pdf). "c,oll to ,lleddix ,. iittoloh  add Codfidedce Te,ps fo, 
Gede,aliittoloh  id tte NCGMP09 Tlrm  for GloMaelrial aid 
GloMaelrialCoifdlicl ii ehl GlMS docspedtatod (l. 1 2546 add followidh).

(Do ehl followiig for j  e oil or ewo  iie ,  o yo  kiow whae lilie ally i  lxplceld. 
Noel ii GlMS ehly hail rliamld a  "GloMaelrial" whae ehly   l eo call 
GlilralLiehology.)

b. Fo, eact pal sdit id table DescriptionOfMapUnits  fidd tte Gede,aliittoloh  
GloMaelrial te,p ttat  os ttidk best fits. Col  add laste tte Gede,aliittoloh  
GloMaelrial te,p idto tte all,ol,iate ,ow of tte Gede,aliittoloh  GloMaelrial  
colspd id DescriptionOfMapUnits.  (A  yo  will  ll ii Applidix A, ehl l glilral 
elrm  arl ehiig  likl "Sldimlieary maelrial", or plrhap  morl  plcifc oil  likl 
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"D il  aid".  Whli yo  click oi ai clll ii GloMaelrial ie will prl lie a drop-dowi 
box of ehl allowld choicl .  Blforl clickiig yo  may waie eo makl ehl col mi widlr 
 o yo  cai  ll ehl f ll elxe for ehl choicl .)  ,lso add tte Gede,aliittoloh  
GloMaelrialCodfidedce te,p (Hiht  Medisp  iow; lahe 1 34) ttat  os fidd 
all,ol,iate.  Ie i  OK if io GlilralLiehology GloMaelrial  elrm fe  wlll—fid ehl 
bl e-ftig elrm, liehlr a glilral elrm ehae i   iiiformatil or a  plcifc elrm ehae 
omie   oml liehologil  wiehii ehl map  iie—aid  le ehl corrl poidiig ial l of 
GlilralLiehologyCoifdlicl eo High, Mldi m, or Low a  appropriael. 

c. Editor Save Edits. Editor Stop Editing.  
d. Close Table DescriptionOfMapUnits. 

E. "et ID valses. Excelt fo, Data"os,ces _ID add ,elated Data"os,ceID valses   os tave dot set ad  _ID 
o, ID valses. Ttese cad be c,eated witt ad NCGMP09 toolbox sc,ilt ttat c,eates dew valses fo, ad  
pissidh valses add l,ese,ves existdh ,elatods. 
(Blforl r iiiig ehi , rlmoil ehl MapUiiePoiie  laylr from ehl ToC, aid dlllel ie from ehl 
Glodaeaba l, a  ie ca  l  probllm  ii ehi  ilxe  elp.)

i. Oled tte ArcToolbox widdow. Oled NCGMP09 Tools for Arc10 add dosble-click on (re)Set 
ID values. Id tte Input  NCGMP09-style geodatabase feld  click od tte folde, s pbol add 
davihate to PurcellMtn.gdb io your curreot workspace. "elect it add Add. 

ii. OK.  Wted sc,ilt tas coplleted  Close. 

7.  Check topology, symbolize, and validate your database. 

If yo  hail ioe complleld  elp 6, makl a ilw workiig foldlr, copy ehl coielie  of foldlr 
Exercise1-AutomateAnalogMap\7-CheckSymbolizeValidate iieo ehi  foldlr, aid do bll-click oi 
7PurcellMtn.mxd eo  eare ArcMap.

 (Skip  elp A, chlckiig eopology, a  wl'il alrlady erild eo do ehi .  Do brilfly  kim ehl  eaelmlie 
bllow abo e ehl dirlctoi of fa le .  Thli  kip eo  elp B,  ltig  ymbol .  If yo  do gle ai lrror 
ehlrl, j  e moil oi eo ehl ilxe  elp.

,. Cteck tololoh . Be odd ,eqsi,epedts ttat lides dot c,oss o, dadhle add ttat lol hods deitte, 
ove,lal do, tave hals (stel 4E above)  tte,e a,e otte, aslects of pal tololoh  ttat cad be ctecked 
to hsa,d ahaidst dihitiidh e,,o,s add ipllassible pal ,elatods. 
i.  sd NCGMP09 Topology check sc,ilt. Idlst heodatabase is PurcellMtn.gdb. Cteck tte box to 

validate tte tololoh  of all feats,e datasets— os odl  tave ode  GeologicMap. "et pal scale 
to 1 00000. Yos stosldd't deed to ctadhe ad  otte, idlst valses. OK. Noel ehae ehl Topology  
chlck  cripe i  a work ii progrl  . 

ii. iook at ostlst file Ps,cellMtd_Tololoh  elo,t.ttpl.  Yos stosld see ode Line and point 
topolony e,,o,:

e,,o,s_GeolohicMalTololoh _lide
      1   Must Not Have Gaps   esriTRTAreaNoGaps

Yos pa  also tave ad End-points of fa羻lt arcs that may need fippinn e,,o,  wtict id ttis 
case (ttese faslt lides a,e dot di,ectodal) pa  be ihdo,ed. 
Note tte tables stowidh tow pad  a,cs  add wtat cspslatve ledhtt of a,c  tte,e a,e id tte 
classes “Codcealed codtacts add faslts”  “Codtacts (dot codcealed)”  add “Faslts (dot 
codcealed)”. Ttese cad be ssefsl id idedtf idh dihitiidh e,,o,s. Ode pihtt ipahide ttat fo, a 
la,he  copllex pal ttese pihtt eved teact  os sopettidh abost tte st,ath,alt  of tte 
pal (is it la e,-cake o, dot? Wtat a,e tte sihdificadt sdcodfo,pites?)

B. "et s pboliiatod. Oil of ehl  erligeh  of GIS, aid of ehl NCGMP09  chlma, i  ehae  ymboliiatoi 
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may bl almo e litrlly diiorcld from  lmaitc coielie—ehae i ,  ilikl wieh a paplr map, heavy 
black line illd ioe lq al fault. Wl choo l eo  le  ymboliiatoi  lparaelly from ehl Typl, 
Exi eliclCoifdlicl, aid oehlr attrib el  of a flae rl. Oil adiaieagl of ehi  i  ehae wl cai la ily 
rl- ymboliil a  wl chaigl ehl  call ae which map daea arl eo bl di playld. Zoom o e,  o ehae 
1:24,000  call blcoml  1:100,000  call, aid maiy da hld coieace   ho ld bl  howi a  coiti o  .  
Yo  cai pick liil wlighe  aid color  ehae arl appropriael for yo r di play mldi m. Aid  o oi. 
If  os ctoose to sse FGDC s pboloh  (FGDC Dihital Ca,toh,altic "tadda,d fo, Geolohic Mal 
" pboliiatod  FGDC-"TD-01 3-2006  available od tte web at dhpdb.sshs.hov)   os pa  fidd tte 
NCGMP09 Set Symbol Values sc,ilt tellfsl. 
To aioid ai lrror whli yo  r i ehl followiig  cripe, fr e opli lditig oi ehl Coieace AidFa le  
laylr.  Seop lditig aid  ail ehl rl  le oicl ehl  cripe ha  fii hld.

i.  sd tte NCGMP09 Set Symbol Values sc,ilt. Oled tte ArcToolbox widdow  exladd 
NCGMP09 Tools for Arc10  add dosble-click od Set Symbol Values. 

a. "et Feature dataset to PurcellMtn.gdb/GeologicMap io your curreot workspace. 
b. "et Map scale denominator to 100000. 
c. ,ccelt defaslts fo, tte ,epaidde, of tte sc,ilt la,apete,s.
d. OK. 

ii. Set Symbol Values sses a dictoda,  file that you cao edit to set Symbol valses. Ttis file  
Type-FgdcSymbol.txt  lives id tte Scripts folde, of tte NCGMP09 toolbox add lists Typl valses 
add a co,,esloddidh s pbol idedtfie, f,op tte G"C ipllepedtatod of tte FGDC 
ca,toh,altic stadda,d. 

a. Fo, pad  lide t les (e.h.  codtact  faslt) tte,e a,e eihtt (23) lide s pbols defided id 
tte FGDC ca,toh,altic stadda,d fo, all copbidatods of is o, is dot codcealed  
locatod codfidedce (ce,taid ve,sss all,oxipate ) add existedce/idedtt  codfidedce 
(qse,ied o, dot). Ttese lide t les a,e listed id tte dictoda,  file sdde, tte teadidh 
Einht-fold Lines. 

b. "ope st,scts,al o,iedtatod s pbols tave dife,edt fo,ps deleddidh od wtette, tte 
o,iedtatod is kdowd exactl  o, all,oxipatel —ttat is  wtette, 
OrilieatoiCoifdliclDlgrll  is less ttad sope c,itcal valse. Ttese  add otte, 
st,scts,al o,iedtatod s pbols ttat do dot tave dife,edt fo,ps  a,e listed sdde, 
Two-fold Orientaton Points. 

c. Otte, s pbols a,e idva,iadt odce Typl is hived. Typl-to-s pbol pallidh fo, ssct 
s pbols is hived sdde, My Symbols. 

B  defaslt (bst  os cad ctoose dot to) Set Symbol Values also calcslates sope at,ibste 
valses fo, lol hods id MapUnitPolys. Symbol is set eqsal to Dl criptoiOfMapUiie .Symbol. 
Labll is set to Dl criptoiOfMapUiie .Labll  excelt fo, lol hods fo, wtict 
IdliteyCoifdlicl <> certain  fo, wtict “?” is alledded to tte label. 
B  defaslt (bst ahaid  os cad ctoose dot to)  if ttis is tte GeologicMap feats,e dataset add 
tte,e is ad OrientationPoints feats,e class  Set Symbol Values will c,eate a dew feats,e class 
OrientationPointLabels  add loidts to ttis class witt at,ibste Iicliiatoi  lositod ttese 
loidts acco,didh to tte dictates of tte FGDC stadda,d  add add a la e, to  os, pal 
coplositod ttat d,aws ttese labels witt tte fodt add siie slecified b  tte FGDC 
ca,toh,altic stadda,d. Yos pa  fidd ttis a hood sta,t towa,ds co,,ectl  lositoded dil 
dspbe,s. 

C. Validate  os, database add fix e,,o,s ttat a,e idedtfied. 
i. Fi,st  Compact and Backup  os, database witt tte sc,ilt id tte NCGMP09 toolbox.

(Thi  will probably fail agaii.  If ie dol , j  e moil oi eo ehl ilxe  elp.) 
ii.  sd tte NCGMP09 Validate Database sc,ilt. 
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(A  wl haili'e fllld ii all ehl rlq irld iiformatoi eabll , aid haili'e fxld ehl eopology 
i   l  ca  ld by flae rl  lxelidiig o e idl ehl o eliil, ehl followiig heml fll  will probably  
rlpore loe  of probllm .  J  e look ehro gh eho l rlpore  brilfly.  Thl HTML fll  will bl ii 
yo r maii exercise_12 dirlceory, aid do bll-clickiig oi ehlm ii Wiidow  Explorlr  ho ld  
opli ehlm ii a brow lr.) 

a. Oled tte ostlst file Ps,cellMtd-Validatod.ttpl. Wtat e,,o,s a,e idedtfied?  iikel  
l,obleps idclsde:

1 . Excess fields. Yos edabled e,,o, t,ackidh od all feats,e classes add tables. 
Wtile extedsiods to tte sctepa a,e dot e,,o,s   os a,e likel  to ctoose dot 
to ,etaid ttis idfo,patod id tte fidal  lsblic  ve,siod of tte database. Id tte 
ArcCatalog widdow  davihate dowd to PurcellMtn.gdb/GeologicMap id  os, 
cs,,edt wo,kslace  exladd  ,ihtt-click od eact feats,e class  davihate dowd 
to Manage  add Disable Editor Tracking. OK.  Id tte Table Of Contents 
widdow  ,ihtt-click od tte co,,esloddidh la e,  oled tte at,ibste table  
davihate to tte edito, t,ackidh fields  add delete ttep.  eleat fo, all feats,e 
classes id GeologicMap.  eleat fo, tables DataSources  
DescriptionOfMapUnits  add Glossary.  Hlrl i  a  cripe ehae illd  eo bl 
writtli!

2. Uddeeded feats,e classes. MapOutline add tics (at tte ,oot level of tte 
heodatabase) a,e excess. Delete ttep. Yos tave dot ssed 
GeologicMap/MapUnitPoints add it is oltodal. Delete it. 

3. Missidh Glossary edt,ies. Validate Database alpost ce,taidl  will tave 
idedtfied seve,al te,ps ttat stosld be defided id tte Glossa,  table. 

a. Oled tte Glossary table fo, editdh add add tte pissidh te,ps. 
b. Yos also deed to add valses of Glo  ary_ID fo, eact dew te,p  

eitte, padsall  o, b  ,sddidh tte NCGMP09 (re)Set ID values sc,ilt 
wted  os a,e dode editdh Glossary.

c. Gede,aliittoloh  add Gede,aliittoloh Codfidedce te,ps a,e defided 
id ,lleddix , of tte NCGMP09 stadda,d. These terms should oot 
oe redefioed! ,s a codvediedce to tte sse,s of  os, database  col  
add laste tte ,elevadt defiditods idto Glossa, . ,dd tte all,ol,iate 
valse of Defiditod"os,ceID. 

d. Editor Save Edits. Editor Stop Editing.  
4. Validate Database is dot spa,t edosht to idedtf  pissidh defiditods  

pissidh pal sdit desc,iltods  o, loss  desc,iltods of data sos,ces. 
Howeve,  it does list tte codtedts of tables DataSources  
DescriptionOfMapUnits  add Glossary. "cad ttese. Fix ttat wtict deeds 
fixidh. 

iii.  e-,sd tte Validate Database sc,ilt. Fix ad  ,epaididh e,,o,s.  eleat sdtl dode. 

8.  Make a map image and print it.

,. Go to View > Data Frame Properties...  od tte ,,cMal peds ba,. Udde, tte General tab  edss,e 
ttat Reference Scale: = 1:100,000. 

B. ,dd sdado,ded ContactsAndFaults to  os, pal coplositod. Eitte, oled tte ,,cCataloh widdow 
add d,ah  o, click tte ,dd Data icod add ,dd Data…  Udcteck Codtacts,ddFaslts1 0024KK. (Raehlr 
ehai  ichlckiig Coieace AidFa le 24K,  ichlck LTYPE Exi eliclCoifdlicl, IdliteyCoifdlicl, aid  
LocatoiCoifdliclMlelr .  Noel ehl l "adorild" ilr ioi  wo ld hail blli of morl   l if wl had 
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ace ally digitild Coieace AidFa le  wiehii ArcMap, raehlr ehai importig ehlm ii  haplfll .)  
C. Go back to Table Of Contents. " pboliie la e,s O,iedtatodPoidts  Geolohiciides  add 

Codtacts,ddFaslts witt tte FGDC ca,toh,altic stadda,d. 
i. Id tte Table Of Codtedts widdow  dosble-click od O,iedtatodPoidts. Id tte Layer Properties 

widdow  click od tte Symbology tab.  Id tte Show: box  select Categories > Match to 
symbols in a style. Fo, Value Field  select Symbol. Fo, Match to symbols in Style  click tte 
Browse… bstod add sc,oll dowd add select FGDC_GSC_20100414.style. Open. 

ii. Back at tte ia e, P,ole,tes widdow  click Match Symbols. Udcteck <all other values>. 
iii. Fo, O,iedtatodPoidts ooly  click tte Advanced bstod add select Rotation…  "et Rotate 

Points by Angle in this feld: to Azimuth. Edss,e ttat tte Geographic ,adio bstod is 
selected.  OK.    Sll ehl ioel aboil abo e  ltig ehl roeatoi of ehl iicliiatoi elxe. 

iv. OK. 
v.  eleat fo, Codtacts,ddFaslts add Geolohiciides. 

To het ttis to wo,k ,ihtt fo, Codtact,ddFaslts we fi,st deed to fill id sope as  et pissidh 
idfo,patod id tte ,t,ibste table.  

D. Fo, MalUditPol s  s pboliie via Match to Symbols in Style  Value Field Symbol  add at Match to 
symbols in Style  Browse… to add select USGS Symbols.style. Thi   eyll fll may ioe bl prl lie ii 
yo r ArcMap ii eallatoi. Ie i  aiailabll ii ehl Rl o rcl  foldlr of ehl co r l CD. 

E. ,djsst tte labelidh of MalUditPol s. 
Yo  will probably waie di play of ehl Map O eliil, ehl OrilieatoiPoiie , GlologicLiil , 
MapUiiePoly , aid Coieace AidFa le  liablld, b e lilryehiig ll l iicl diig ehl origiial pig imagl 
di ablld.  Ie makl  ie eoo hard eo  ll ehl oilrlyiig  ymbol .

F. "witct to ia ost View add adjsst. Save. File > Export Map…  add Save as type:   PDF (*.ldf).  Noel 
ehae yo  may hail eo iaiigael eo a diflrlie Save in: foldlr. 

G. Oled tte PDF witt ,dobe  eade, add idslect. If eve, ttidh is OK  l,idt. 

Whae eo e ri ii:

Work ehro gh ehl aboil lxclrci l ae lla e eo ehl poiie ehae yo  cai glilrael a pdf map  howiig ehl 
 idlrlyiig pig imagl,   plrpo ld by Map Uiie Polygoi  wieh appropriael color  aid labll , a flw 
Orilieatoi (Dip) poiie , aid ehl aitcliil liil.  Sail a copy of ehae imagl aid mail ie eo ml.

Try eo fii h ehl  elp  of pop latig ehl f ll GlMS  le of eabll  wieh ehl eypl of iiformatoi dl cribld  
ii ehl  elp  aboil -- b e doi'e ilcl  arily  plid ehl tml eo lielr lilry MapUiie dl criptoi or 
So rclID ial l.  Cllarly ie cai gle eldio   lielriig all eho l dleail .  For THIS cla  , ehl maii poiie of 
ehae pare of ehl lxclrci l i  eo  idlr eaid ii glilral whae eypl of iiformatoi i  lxplceld ii a fial 
GlMS  eaidard  map. 

Do ery eo lielr lio gh iiformatoi iieo ehl Coieace AidFa le , OrilieatoiPoiie , aid 
GlologicalLiil  eabll   o ehae ehl di play of eho l flae rl  i  corrlce.
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Notes on QGIS GeoReferencing.

(These are all notes added by RRH, but to make it easier to read, since they don't need to be called 
out as different from the original USGS text, I will just print them in black.)

While ArcGIS can accept the world coordinates of the Control Points in (latitude, longitude), for 
QGIS, if we are going to output the map in Washington State Plane N-4601 it's simplest if we 
actually enter the world coordinates (easting, northing) in that projection.  Also, while ArcGIS can 
accept just the corner coordinates and then the tic spacing, for QGIS we'll need to coordinates of each 
corner point.

While there are local tools which could convert from the (longitude, latitude) listed on the map to the 
projection (easting, northing), its simplest to use the on-line converter provided by the National 
Geodetic Survey, at <https://www.ngs.noaa.gov/NCAT/>.  To use it we will need to enter the 
(longitude, latitude, altitude) for each point.  (The altitude has only a small effect on the conversion, 
but for completeness I've looked it up using the contours on the map.)  For the four points, in 
NAD1927 (see the note below), we have         
     Lat.    Long.     Elev.                Lat.    Long.    Elev.

NW:  46.625  -121.875  1085m         NE:    46.625 -121.750   720m

SW:  46.500  -121.875   652m         SE:    46.500 -121.750  1426m

When I input these into the converter as described below, I get coordinates of:
     Easting        Northing              Easting        Northing  

NW:  1,378,312.332  -135,084.517     NE:  1,409,727.459  -135,484.552

SW:  1,377,695.466  -180,681.653     SE:  1,409,184.609  -181,082.420

You clearly don't need these to thousandths of a foot, but the converter can give that.
The converter outputs numbers with commas to make them easier to read, but QGIS won't let you 
paste text including those commas, so here is a copy without those them which you can use for 
cutting and pasting.
     Easting        Northing              Easting        Northing  

NW:  1378312.332  -135084.517        NE:  1409727.459  -135484.552

SW:  1377695.466  -180681.653        SE:  1409184.609  -181082.420

To generate the above coordinates in the converter, select NAD1927 as the input datum and 
NAD1983 (2011) as the output datum.  (Note that output 1983 datum is what is specified by the 
USGS example in order to match other potential data in the project.)  Enter the latitude, longitude, 
and elevation, then if necessary click Convert.   The converter will output numbers in a varieties of 
systems, such as UTM and SPC (State Plane Coordinates).  For the latter it outputs meters, 
international feet, and US feet, and we want the latter.  It also lets you chose the output State Plane 
projection.  Purcell Mountain is actually in the southern part of Washington and so by default the 
converter will output coordinates in the WA S-4602 projection used for the southern part of the state. 
However to match other potential data in this USGS example we actually want coordinates in 
WA N-4601, normally used for the northern part of the state.  To force output in that, clear the Zone 
field under SPC and start to type in WA.  It should bring up to boxes showing the WA N-4610 and 
WA S-4602 options.  Click on the former.  Finally, copy the easting and northing as given in US feet.
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Importance of the Input Map Datum:  It is very important to specify the datum of the input map 
correctly.  Since I didn't have the collar information from the full map I initially assumed the map 
was marked in NAD83 (although the ISNAD27 option checked in the ArcGIS instructions should 
have been a clue that assumption was wrong.)  When I originally did the conversion I specified that 
the tics were at the above (latitude, latitude) in NAD83, and that gave the following projected 
coordinates:
     Easting        Northing              Easting        Northing        

NW:  1,378,615.018  -135,025.944     NE:  1,410,029.627  -135,425.674       WRONG VALUES!!!!

NW:  1,377,997.779  -180,623.855     SE:  1,409,486.453  -181,024.523       WRONG VALUES!!!!

If you compare them to the above ones you will see that the easting differs about 303 ft and the 
northing differs by about 58 feet.  I originally digitized the contacts with the wrong settings, and 
discovered that when imported into ArcGIS they were all positioned wrong by the above offset.  I 
could have gone back and redigitized them all, but in this case, since the offset was the same for all 
points, I used the QGIS vector Geoprocessing / Affine Transformation tool to shift all the 
vector points by the above offset and make them properly align with the map.

Now that we have the (correct) world coordinates of our four control points we can GeoReference the 
image in QGIS.

To GeoReference in QGIS first use the main menu Plugins / Manage and Install Plugins  
dialog to be sure the Georeferencer GDAL plugin is installed and active.  (It is one of the default 
QGIS plugins so it should be installed, but might not initially be activated.  If activated the box in 
front of it in the plugin list will be checked.)  Next in the main menu go to 
Raster / Georeferencer to open a new window which will have two panels:  the upper for the 
image and the lower for a list of the control points.  Use File / Open Raster and select the 
PurcellMtnRRH.png file.  Set as the CRS you will use 
NAD_1983_StatePlane_Washington_North_FIPS_4601_Feet (which is also known as 
EPSG:102748).  We will enter the "world" coordinates for our known control points using the ones 
obtained above from the NCAT converter.  As described above, in QGIS it is simplest if we actually 
use  (easting, northing) in the Washington FIPS_4601 State Plane.  If you have previously defined 
control points then they will appear in the bottom panel.  (By default they are saved in a file with the 
same name as the raster, with .points appended to the name.)  If you don't want to use some of 
them then right click on that row and Remove it, or at least "uncheck" it so it won't be used in the 
warping calculation.

Select the Add control points tool, zoom in to each of our four control points, click on the point, 
then enter the appropriate (easting, northing) as measured in the WA N-4601 (US feet) 
projection.  You can use the mouse scroll wheel to zoom in and out.  Also note if you are cutting and 
pasting from the above coordinate text, you need to paste text without any commas.  QGIS will 
refuse to allow you to paste text with commas.  Once you have entered all four points, from the menu 
select Settings / Transformation Settings.   In the window which opens accept the default 
"Thin Plate Spline" for interpolating the transformation between screen and world coordinates.  
Under Output Raster click "..." and navigate to a reasonable writable directory for placing an 
output image.  Accept the default name PurcellMtnRRH_modified.tif.  The program will 
produce a tif image "warped" to the new projection and the "geotif" format file will contain embedded 
information about the real world coordinates.  For tif there are several compression options.  Select 
Deflate which can be read by most systems and does not introduce compression artifacts in the 
image.  One of the default parameters will be to load the image into the QGIS canvas when done.  
We could also specify target resolution and other options, but the defaults are usually reasonable. 
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Once done specifying parameters select OK.  

Note that we actually don't know what input projection was used in generating the original map.  
With just three or four control points we are assuming there is some linear relationship between 
screen coordinates and world coordinates.  If the map covered a large enough region where the 
projection distortion pattern changed, we would need to define many more control points scattered 
across the map.

Next, from the menu select File/Start Georeferencing which produces the TIF image warped 
to the new projection and matched to the control points, and then loads it into the QGIS Canvas.  
You can now close the Georeferencing window.  It will ask you if you want to save the control points.  
Say yes, and they will be written to the default .point file described above.

With the image loaded you could now create new shapefiles tracing features on the map.  If this is 
the first image loaded that will set the "Project CRS" (used to control the display) to the same CRS as 
the image, namely  NAD_1983_StatePlane_Washington_North_FIPS_4601_Feet .  If we output 
that shapefiles using that same projection they will have the greatest accuracy, as internally they 
will have feature (x,y) given as easting and northing in that projection.  With QGIS you can also 
specify output in other projections, but then QGIS will need to Transform coordinates into the new 
system, which can potentially introduce some (usually small) errors.  For this project I have tried to 
keep all shapefiles in this FIPS 4601 system, as it is important to make sure our contacts line up 
exactly with each other.

QGIS Digitizing Tips

As mentioned in the main Exercise instructions, it is critical for GeMS that faults and contacts all 
meet cleanly so that they divide up the whole area of the map into well defined polygons 
corresponding to the different rock unit exposures.  GeMS  will also be unhappy if any contacts or 
faults (or segments along them) are duplicated.  It also will complain if a contact or fault is broken 
up into segments without some good reason, like a change in its properties (certain to uncertain).   
Furthermore, contacts lines never cross each other -- although they could meet at "triple junctions" 
where three different rock exposures touch at one point.
 
It also turns out that there are peculiar interactions in the GeMS software between the contacts and 
the Map Outline, which is treated as a contact but is clearly an unusual one.  The following tips help 
generate contact and fault shapefiles with which GeMS is more likely to be satisfied.

1)  Be sure that any junction between contacts (or faults) occurs at a well defined vertex.  Use 
snapping to ensure that the end-vertices of the three possibly joining lines all have exactly the same 
coordinates.  

2)  If you do have an apparently single contact which changes character, then digitize it as two 
features, again using snapping so the last vertex of one matches exactly the first vertex of the 
second.  Make sure some attribute, like LocationConfidenceMeters, changes at the boundary.

3)  If you have a contact which forms a closed loop, digitize it as a "line", not a polygon, and use 
snapping to make the last vertex coincide exactly with the first.  But see the note below in case the 
loop crosses the map outline.
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4)  If you do have a contact loop but the loop crosses the Map Outline, make sure the first/last vertex 
lies outside the map outline.  When constructing the map GeMS will clip the contact at the Outline 
and if the first/last vertex is within the outline that contact gets broken into a left half / right half 
pair which violates the rules that contacts should NOT (without a good reason) have multiple parts.

5)  Contacts (and sometimes faults) should always end where they meet some other feature, or they 
are marked by GeMS as "Dangling Contact" errors.  When digitizing within ArcGIS contacts end 
either at another contact or fault, or at the Map Outline.  We will see in QGIS that we can leave 
contacts dangling after they move outside the Map Outline, but this will be flagged as an error we 
will have to override.

6)  Each created polygon needs to be labeled with one and only one MapUnitPoint, or the unit names 
need to be added later by other means.  If using MapUnitPoints, remember that the Map Outline can 
potentially break a single rock exposure into separate exposures which reach into the Outline from 
different sides of the map.  You will need to add an extra MapUnitPoint for each of those ultimate 
polygons as the GeMS script isn't smart enough to follow the exposure outside the outline and then 
back inside again. 

QGIS Outline Polygon

For some later steps it is convenient to have a shapefile which is a polygon representing the map 
outline, and we want the outline points to be exact.  I have created a CSV text file   
outine_points_fips4601.csv which contains those coordinate using the FIPS_4601 CRS.  To 
create a point shapefile in QGIS select the Add Delimited Text tool from the left edge menu, or 
from the Layer / Add Layer / Add Text Delimited Layer menu.  Browse to select the above 
csv file.  For File format select CSV.  Look through the other parameter choices but the defaults 
are probably good.  If they do look good click OK.  It will ask you want CRS is used for these 
coordinates.  Select NAD_1983_StatePlane_Washington_North_FIPS_4601_Feet (or 
equivalently, EPS: 102748).   If that is the Project CRS, then it should be the default choice.  If you 
have the georeferenced map loaded, then you should see points added which match the maps control 
points.  Next we will turn this four point file into a polygon.  Install the plugin Points2One if it isn't 
already available and start it from the menu Vector / Points2One .  Select our 
outline_points_fips4601 as the input layer, check Create polygons, and create an output shapefile 
called  outline_polygon_fips4601.  Also check the Add results to canvas box.  (Note for plugins 
like this the system often forgets what default directory results should be written to.)   (An alternate 
to using this plugin is to use  Vector / Geoprocessing / Convex Hull and while it works for this simple 
case, computing a "Convex Hull" is overkill for a simple polygon like this.)  Once the polygon is 
create it you'll want to edit its style.  The default is Single symbol / Fill / Simple fill but 
that makes the whole polygon opaque.  Click on Simple fill and  in the dialog box which appears, 
to the right of Fill click on the down arrow and select Transparent Fill. Click on the Outline color 
and select something which stands out.  Finally, perhaps adjust the outline width.

Part of the reason to create the above outline is that, as we will see in ArcGIS, we can encounter 
problems if faults or other lines extend outside the outline of the map.  We can use the above outline 
polygon to create a clipped version of those lines.  From the main QGIS menu select 
Vector / Geoprocessing tools / Clip .  Select the contacts_fips4601 layer as input, the 
outline_polygon_fips4601 layer as the clip layer, and tell it to output the result to the shp file  
contacts_clipped_fips4601 then click Run.  (Hint:  Make sure no features are selected when you 
run this, or only the selected features will be included in the possible output.)
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